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QIAGEN® Sample and Assay Technologies 
QIAGEN est le premier fournisseur de technologies novatrices d’échantillons et 
d’analyses, permettant d’isoler et de détecter le contenu de n’importe quel 
échantillon biologique. Nos produits et services ultramodernes de grande 
qualité garantissent un succès total, de l’échantillon jusqu’au résultat. 

QIAGEN fixe les normes en matière de : 

 purification d’ADN, d’ARN et de protéines ; 

 analyses d’acides nucléiques et de protéines ; 

 recherche micro-ARN et interférence ARN ; 

 automatisation des technologies d’échantillons et d’analyses. 

Notre mission est de permettre à notre clientèle de réussir et d’accomplir des 
progrès décisifs. Pour plus d’informations, visiter www.qiagen.com. 
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Symboles 

 
Dispositif médical de diagnostic in vitro 

 

Marque CE, conformément à la Directive européenne sur 
les dispositifs médicaux de diagnostic in vitro (IVD) 
98/79/CE 

 
Référence 

 Numéro du matériel 

 
Fabricant légal 

 
Se reporter au manuel 

 
Remarque importante 

Utilisation prévue 
Le logiciel PyroMark Q24 MDx est l’application associée au pyroséquenceur 
PyroMark Q24 MDx servant à la détection des modifications des positions 
variables spécifiées de la séquence d’ADN qui peuvent avoir une signification 
clinique. 

Le PyroMark Q24 MDx est destiné au diagnostic in vitro en Europe. 

Limitations de l’utilisation du produit 
Le logiciel PyroMark Q24 MDx est destiné à des utilisateurs professionnels, tels 
que les techniciens et les médecins formés au fonctionnement du système du 
même nom et aux techniques de la biologie moléculaire. 

Toutes les opérations doivent être réalisées conformément à ce manuel, aux 
messages qui s’affichent sur l’écran du PyroMark Q24 MDx tels qu’indiqués 
dans le Manuel d’utilisation du PyroMark Q24 MDx, aux indications des 
manuels des kits QIAGEN compatibles avec le système, au support technique 
de QIAGEN et dans les limites définies par les spécifications techniques. 

Le matériel nécessaire à la préparation des échantillons pour l’analyse par 
pyroséquençage n’est pas inclus.  

Le produit est exclusivement destiné à une utilisation sur le pyroséquenceur 
PyroMark Q24 MDx. 
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Pour des résultats optimaux, il est impératif de respecter scrupuleusement les 
indications du manuel d’utilisation de l’appareil et du présent guide. La dilution 
des réactifs autre que celle décrite dans le présent manuel n’est pas 
recommandée et entraîne une perte de performances. 

Prêter attention aux dates limites d’utilisation et aux conditions de stockage 
imprimées sur l’emballage et les étiquettes des composants. Ne pas utiliser de 
composants périmés ou stockés dans de mauvaises conditions. 

Les résultats fournis par le système PyroMark Q24 MDx doivent impérativement 
être interprétés dans le contexte des observations cliniques et des résultats 
d’analyse de laboratoire pertinents. 

Garantie des produits et garantie de satisfaction 
QIAGEN garantit la performance de tous ses produits de la manière décrite 
dans sa documentation. L’acheteur doit déterminer la pertinence du produit 
pour son usage particulier. Si un produit n’offre pas une performance 
satisfaisante pour toute autre raison qu’un mauvais usage, QIAGEN le 
remplacera gratuitement ou remboursera le prix d’achat. Nous nous réservons 
le droit de changer, altérer ou modifier un produit pour améliorer sa 
performance et son esthétique. Si un produit QIAGEN ne répond pas aux 
attentes, appeler le Service technique ou le distributeur local. Nous proposons 
au choix le remboursement ou l’échange du produit. Des conditions distinctes 
s’appliquent aux instruments scientifiques, produits de services et produits 
expédiés sur glace sèche de QIAGEN. Se renseigner pour en savoir plus. 

Une copie des conditions générales de QIAGEN peut être obtenue sur 
demande et figure également au dos de nos factures. Pour toute question sur 
les spécifications ou la performance des produits, appeler les Services 
techniques de QIAGEN ou le distributeur local (voir quatrième de couverture ou 
www.qiagen.com). 

Support technique 
Chez QIAGEN, nous sommes fiers de la qualité et de la disponibilité de notre 
support technique. Nos services techniques sont composés de scientifiques 
expérimentés bénéficiant d’un vaste savoir-faire pratique et théorique en ce qui 
concerne les technologies d’échantillons et d’analyses et l’utilisation des 
produits QIAGEN. Pour toute question ou en cas de difficultés concernant le 
PyroMark Q24 MDx ou les produits QIAGEN en général, nous contacter. 

Les clients de QIAGEN constituent une source d’informations majeure relative 
aux utilisations avancées ou spécialisées de nos produits. Ces informations sont 
utiles à d’autres scientifiques ainsi qu’aux chercheurs de chez QIAGEN. Par 
conséquent, ne pas hésiter à nous contacter pour toute suggestion concernant 
la performance des produits ou de nouvelles applications et techniques. 
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Pour le support technique et plus d’informations, consulter notre Centre de 
support technique à l’adresse www.qiagen.com/Support ou appeler l’un des 
Services techniques de QIAGEN ou des distributeurs locaux (voir quatrième de 
couverture ou le site www.qiagen.com). 
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Introduction 

À propos de ce guide d’utilisation 
Le présent guide d’utilisation renseigne sur les fonctions et les caractéristiques 
du logiciel PyroMark Q24 MDx. Pour des informations complètes sur l’entretien, 
la maintenance et l’utilisation du séquenceur et du poste de travail sous vide, 
consulter le Manuel d’utilisation du PyroMark Q24 MDx. 

Le présent guide d’utilisation décrit les caractéristiques du logiciel et des outils 
associés pour permettre à l’utilisateur de gérer et modifier les fichiers et les 
analyses. 

Le manuel est composé des sections suivantes : 

 Introduction 

 Logiciel PyroMark Q24 MDx 

 Démarrage du logiciel 

 Configuration d’une analyse AQ ou CpG 

 Configuration d’une analyse SQA 

 Configuration d’un run 

 Traitement d’un run sur l’appareil PyroMark Q24 MDx 

 Analyse du run 

 Affichage, impression et enregistrement des rapports d’analyse 

 Gestion des méthodes de l’appareil 

 Trucs et astuces 

 Résolution des principaux problèmes rencontrés 
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Logiciel PyroMark Q24 MDx 
Le système PyroMark Q24 MDx est une solution complète comprenant un 
appareil, un poste de travail sous vide, des réactifs et un logiciel.  

Il présente les avantages suivants : 

 Quantification haute résolution des mutations bi-, tri- ou tétra-alléliques 

 Génotypage et quantification des InDels 

 Dans les analyses AQ et CpG, utilisation du contexte de la séquence 
comme témoin de qualité intégré 

 Analyse de la méthylation en présence de polymorphismes 
mononucléotidiques (SNP) 

 Dans les analyses de méthylation, témoin de qualité intégré du traitement 
par le bisulfite 

 Détermination de la séquence par appel de bases avec évaluation de la 
qualité 

Modes d’analyse 
 

 

 

Trois modes d’analyse sont proposés sur le 
logiciel PyroMark Q24 MDx :  

 AQ : Différentes études de quantification et 
d’analyse du génotype des SNP et des InDels 

 CpG : Analyse de la méthylation de plusieurs 
sites de dinucléotides CpG consécutifs 

 SQA : Détermination de séquences inconnues 
par appel de bases  

Les trois types d’analyses peuvent être réalisés sur 
la même plaque PyroMark Q24. Pour passer d’un 
mode d’analyse à un autre, sélectionner « AQ », 
« CpG » ou « SQA » dans la barre d’outils de 
l’écran d’analyse. 
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Navigateur des raccourcis 
Le navigateur des raccourcis offre un moyen simple et rapide d’accéder au 
contenu des dossiers ainsi qu’aux fichiers d’analyse et de run les plus utilisés. 
 

 

Les icônes suivantes sont utilisées pour 
renseigner sur les fichiers : 

 Fichier d’analyse AQ 

 Fichier d’analyse CpG 

 Fichier d’analyse SQA 

 Fichier de run non traité 

     Fichier de run      
         traité 

 Raccourci erroné. Causes 
possibles : serveur réseau 
momentanément 
indisponible ou fichier ou 
dossier déplacés, renommés 
ou supprimés en dehors du 
logiciel 

  
Ajout et suppression de raccourcis, mise à jour du contenu d’un dossier et 
affichage des propriétés d’un fichier et d’un dossier : 

 Pour ajouter un raccourci vers un dossier ou un lecteur, cliquer sur « Add 
Folder Shortcut » (Ajouter un raccourci vers un dossier) ou cliquer avec le 
bouton droit de la souris sur le dossier « Shortcuts » (Raccourcis) puis 
sélectionner « Add Folder Shortcut » dans le menu contextuel. 

 Pour ajouter un raccourci vers un fichier, cliquer sur « Add File Shortcut » 
(Ajouter un raccourci vers un fichier) ou cliquer avec le bouton droit de la 
souris sur le dossier « Shortcuts » puis sélectionner « Add File Shortcut » 
dans le menu contextuel. 

 Pour supprimer un raccourci, cliquer dessus avec le bouton droit de la 
souris puis sélectionner « Remove Shortcut » (Supprimer le raccourci) dans 
le menu contextuel. (Il est impossible de supprimer séparément les fichiers 
et les sous-dossiers d’un dossier de raccourcis.) 

 Pour mettre à jour le contenu d’un dossier, cliquer avec le bouton droit de 
la souris sur ce dossier puis sélectionner « Refresh » (Actualiser) dans le 
menu contextuel. 
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 Pour afficher les propriétés d’un fichier ou d’un dossier, par exemple pour 
voir les paramètres d’un run, cliquer avec le bouton droit de la souris sur 
ce fichier ou ce dossier puis sélectionner « Properties » (Propriétés) dans le 
menu contextuel. 

Remarque : Lorsque le pointeur de la souris est placé sur un fichier dans 
le navigateur des raccourcis, une infobulle affiche la note de l’analyse dans 
le cas des fichiers d’analyse ou l’ID de plaque dans le cas des fichiers de 
run (si ces informations ont été saisies). 

Création, ouverture et copie des fichiers, affichage du journal d’un run traité :  

 Pour créer un nouveau fichier d’analyse, cliquer avec le bouton droit de la 
souris sur le dossier souhaité puis sélectionner « New Assay » (Nouvelle 
analyse) et le type d’analyse dans le menu contextuel. Saisir le nom du 
fichier puis appuyer sur « Enter » (Entrée). Pour configurer l’analyse, voir 
page 20 (AQ ou CpG) ou page 34 (SQA). 

 Pour créer un nouveau fichier de run, cliquer avec le bouton droit de la 
souris sur le dossier souhaité puis sélectionner « New Run » (Nouveau run) 
dans le menu contextuel. Saisir le nom du fichier puis appuyer sur 
« Enter ». Pour configurer un run, voir page 37. 

Pour copier le fichier d’un run traité et répéter le run, cliquer avec le 
bouton droit de la souris sur ce fichier puis sélectionner « Copy and Rerun » 
(Copier et répéter le run) dans le menu contextuel.  

Remarque : Seules les données de configuration du run sont copiées, pas 
les données du run ni de son analyse.  

 Pour copier un fichier, cliquer avec le bouton droit de la souris sur le 
dossier contenant ce fichier puis sélectionner « Explore » (Parcourir) dans le 
menu contextuel. Windows® Explorer (Explorateur Windows) s’ouvre. Pour 
plus d’informations, appuyer sur la touche « F1 » afin d’ouvrir l’aide en 
ligne de Windows Explorer (Explorateur Windows).  

Remarque : Afin d’éviter la perte de données, ne pas copier de fichier 
ouvert dans le logiciel PyroMark Q24 MDx.  

 Pour ouvrir un fichier, double-cliquer dessus ou cliquer dessus avec le 
bouton droit de la souris puis sélectionner « Open » (Ouvrir) dans le menu 
contextuel. Pour ouvrir le fichier d’un run traité, sélectionner « Open with » 
(Ouvrir avec) suivi du mode d’analyse (« AQ », « CpG » ou « SQA »). 

 Pour afficher les paramètres et le journal de run pour un fichier de run 
traité, cliquer avec le bouton droit de la souris sur ce fichier puis 
sélectionner « Run Information » (Informations sur le run) dans le menu 
contextuel.  
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Menus et barres d’outils principaux 
 

Menu et barre d’outils 
File (Fichier) 

 

 

Pour créer un nouveau fichier d’analyse, sélectionner 
« New Assay » ou cliquer sur  dans la barre d’outils 
puis sélectionner le type d’analyse à créer dans le 
menu contextuel. Pour configurer l’analyse, voir 
page 20 (AQ ou CpG) ou page 34 (SQA). 

Pour créer un nouveau fichier de run, sélectionner 
« New Run » ou cliquer sur le bouton vert  dans la 
barre d’outils. Pour configurer un run, voir page 37. 

Pour ouvrir un fichier d’analyse ou de run enregistré, 
sélectionner « Open » ou cliquer sur  dans la barre 
d’outils. 

Pour créer un nouveau run à partir de l’agencement 
d’une plaque sur lequel figure les ID d’échantillons et 
les notes (facultatives) défini dans un fichier texte 
délimité par des tabulations ou des virgules (*.tsv, 
*.txt ou *.csv), sélectionner « Create New Run from 
Sample Layout File » (Créer un nouveau run à partir 
d’un fichier d’agencement d’échantillons) dans le 
sous-menu « Import » (Importer). Voir page 42.  

Pour créer une nouvelle analyse AQ ou CpG à partir 
d’un fichier d’analyse (*.xml) créé dans le logiciel 
PyroMark Assay Design, sélectionner « Create New 
AQ/CpG Assay from Assay Design File » (Créer une 
nouvelle analyse AQ/CpG à partir d’un fichier Assay 
Design) dans le sous-menu « Import ». Le logiciel 
importe la séquence à analyser et les noms des 
positions variables.  

Pour enregistrer les modifications apportées au 
fichier actif, sélectionner « Save » (Enregistrer) ou 
cliquer sur  dans la barre d’outils. Si le fichier n’a 
encore jamais été enregistré, sélectionner un 
emplacement et saisir le nom de fichier dans la boîte 
de dialogue qui s’ouvre. 

Pour enregistrer une copie du fichier actif, 
sélectionner « Save As » (Enregistrer sous). 
Sélectionner un emplacement et saisir le nom de 
fichier dans la boîte de dialogue qui s’ouvre. 

Pour fermer le logiciel, sélectionner « Exit » (Quitter). 
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Menu Tools (Outils) 
pour les fichiers de 
runs non traités 

 

Pour afficher les paramètres des méthodes de 
l’appareil et, si nécessaire, importer ou configurer de 
nouvelles méthodes en fonction des paramètres 
fournis par QIAGEN, sélectionner « Instrument 
Methods » (Méthodes de l’appareil). (Voir Gestion 
des méthodes de l’appareil, page 63).  

Pour afficher la configuration de la plaque et une 
liste des volumes requis de mélange d’enzymes, de 
mélange de substrats et de nucléotides pour le fichier 
actif, sélectionner « Pre Run Information » 
(Informations avant le run). Pour imprimer le rapport, 
cliquer sur .  

Remarque : Pour imprimer le rapport « Pre-Run 
Information » en couleur, activer l’option « Print 
background colors and images » (Imprimer les 
couleurs et les images d’arrière-plan) d’Internet 
Explorer dans « Tools/Internet 
Options/Advanced/Printing » (Outils/Options 
Internet/Avancés/Impression en cours). 

Menu Tools pour les 
fichiers de runs traités 

 

Pour afficher les paramètres et le journal de run pour 
le fichier de run actif, sélectionner « Run 
Information ». Pour imprimer le rapport, cliquer sur 

. 

Pour enregistrer la hauteur des pics de tous les puits 
utilisés dans un fichier texte, sélectionner « Export 
Peak Heights » (Exporter hauteur des pics). 

Pour enregistrer la vitesse d’agitation, la température 
de l’unité de chauffage et la pression dans un fichier 
texte, sélectionner « Export Environment Data » 
(Exporter les données ambiantes). La température 
ambiante, celle du couvercle de la chambre de 
traitement et du réfrigérant sont également 
indiquées. 

Pour enregistrer les intensités et les données de 
distribution dans un fichier texte, sélectionner « Export 
raw Data » (Exporter les données brutes). 

Pour enregistrer les séquences d’appel de bases au 
format FASTA (analyses SQA uniquement), 
sélectionner « Export As FASTA » (Exporter sous 
FASTA). Dans la boîte de dialogue qui s’ouvre, 
sélectionner les puits à inclure (tous ou une sélection), 
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l’ordre de tri des puits (ligne ou colonne) et les bases 
des séquences à inclure (toutes, succès, succès + à 
vérifier ou seulement une plage de contrôle qualité).  

Pour afficher ou enregistrer le journal de toutes les 
analyses réalisées dans le puits sélectionné sous 
forme de fichier HTML, sélectionner « Analysis Log » 
(Journal d’analyse). Chaque analyse est consignée 
avec ses paramètres, son mode (AQ, CpG ou SQA), 
sa version, les résultats (avertissements compris), la 
date et l’heure et le compte d’utilisateur Windows 
utilisé pour réaliser l’analyse (voir Trucs et astuces, 
page 65). 

Il est possible d’importer les fichiers texte (*.tsv ou 
*.csv) dans Microsoft® Excel® ou une autre 
application capable de prendre en charge les 
données séparées par des points-virgules (;) ou des 
tabulations. Ceci est utile à la réalisation de calculs 
supplémentaires sur les données. 

Menu Reports 
(Rapports) pour les  
runs CpG 

 

Le rapport « Analysis Statistics » fournit les statistiques 
d’analyse de tous les puits ou d’une sélection de 
puits. 

Il fournit des informations sur les puits et les résultats 
d’analyse de ceux-ci. 
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Menu Reports pour les  
runs AQ 

 
Menu Reports pour les 
runs SQA 

 

Le rapport « Pyrogram Report » fournit des 
informations et le Pyrogram® (ou pyrogramme) de 
tous les puits ou d’une sélection de puits. 

Le rapport « Full Report » comprend les paramètres et 
le journal du run, les informations sur les puits et les 
résultats d’analyse (pyrogramme compris) pour tous 
les puits ou une sélection de puits. 

Le rapport « SNP Overview Report » comprend les 
génotypes et les évaluations de la qualité de tous les 
SNP et des InDels. Les informations sont présentées 
sous forme de vues d’ensemble des plaques avec 
une plaque par numéro de position. 

Les options de rapport sont disponibles uniquement 
pour les runs traités. Pour plus d’informations sur les 
rapports, voir page 55. 

Remarque : Un lecteur de document PDF doit être 
installé sur l’ordinateur pour pouvoir lire les rapports 
au format PDF. Il est possible de télécharger Adobe® 
Reader® à partir du site www.adobe.com. 

Menu Window 
(Fenêtre) 

 
 

Ce menu permet de basculer dans le logiciel d’un 
fichier ouvert à un autre. 

Menu Help (Aide) 

 
 

Pour ouvrir le présent guide d’utilisation, sélectionner 
« PyroMark Q24 Software Help » (Aide du logiciel 
PyroMark Q24) ou appuyer sur la touche « F1 ». 
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Barre d’outils 
d’analyse 

 

Cliquer sur  et sélectionner « Analyze All Wells » 
(Analyser tous les puits) ou « Analyze Selected Wells » 
(Analyser sélection de puits) pour le fichier de run 
actif. Voir Sélection de puits, page 19.  

Pour afficher les paramètres et le journal de run du 
fichier de run actif, cliquer sur . Pour imprimer le 
rapport, cliquer sur . 

Pour basculer entre les différents modes d’analyse, 
sélectionner « AQ », « CpG » ou « SQA » dans la 
barre d’outils. 

  

 

Histogramme 
 

 
 

Histogramme représentant un résultat théorique d’analyse CpG  

Lors de la configuration d’une analyse AQ ou CpG, la représentation théorique 
des pics de Pyrosequencing® (ou pyroséquençage) attendus est affichée dans la 
zone « Histogram » (Histogramme). L’histogramme utilise les icônes et couleurs 
suivantes : 

 Les positions variables sont mises en évidence par une couleur de fond 
bleu-gris. 

 Lors de l’affichage des pics de référence, ceux-ci sont identifiés par des 
losanges bleus. 

 Les témoins du traitement par le bisulfite sont mis en évidence par une 
couleur de fond jaune. Lors de l’affichage des pics de référence, les 
témoins du traitement par le bisulfite sont identifiés par des losanges 
orange (analyses CpG uniquement). 

Zoom de l’histogramme 

Il est possible d’effectuer un zoom avant sur l’histogramme en en sélectionnant 
une section à l’aide du bouton gauche de la souris. 

Pour effectuer un zoom arrière, cliquer avec le bouton droit de la souris sur 
l’histogramme et sélectionner « Zoom out » (Zoom arrière) dans le menu 
contextuel pour revenir au niveau de zoom précédent ou double-cliquer sur 
l’histogramme pour le réinitialiser sur 100 %. 
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Exportation de l’histogramme sous forme d’image 

Pour copier l’histogramme dans le presse-papier sous forme d’image, cliquer 
avec le bouton droit de la souris sur l’histogramme et sélectionner « Copy as 
Image » (Copier sous forme d’image) dans le menu contextuel. Il est possible 
de coller l’image dans des applications qui prennent en charge le format EMF 
(Enhanced Metafile). 

Pyrogramme 
Il s’agit du graphique résultant de la réaction de pyroséquençage. Les 
nucléotides intégrés sont représentés sous forme de pics sur le pyrogramme. 

Analyses AQ et CpG 
 

 
 
Le pyrogramme des analyses AQ et CpG utilise les informations, les icônes et 
les couleurs suivantes : 

 Le nom du puits et la séquence à analyser figurent dans le coin supérieur 
gauche. 

 Le résultat d’analyse (fréquence des allèles ou pourcentage de méthylation) 
est affiché au-dessus de chaque position variable, par exemple  
(InDel) et . La couleur de fond reflète l’évaluation de la qualité du 
résultat d’analyse. Voir la légende des couleurs page 49. En cas de 
modification d’une évaluation de la qualité par l’utilisateur, cette 
information est représentée par un cadre entourant le résultat d’analyse, 
par exemple . Si le pointeur de la souris est placé sur un résultat 
d’analyse, une infobulle affiche le numéro de la position et les 
avertissements de l’analyse. 

Remarque :  (en blanc) = désélectionné par l’utilisateur.  (en 
blanc) = analyse non prise en charge par le logiciel, cas par exemple 
d’une analyse SNP en mode CpG.  (en rouge) = analyse impossible en 
raison du manque de données. 

 Les positions variables sont mises en évidence par une couleur de fond 
bleu-gris.  

Guide d’utilisation du logiciel PyroMark Q24 MDx   05/2010 17 



 Lors de l’affichage des pics de référence, ceux-ci sont identifiés par des 
losanges bleus.  

 Les témoins du traitement par le bisulfite sont mis en évidence par une 
couleur de fond jaune pâle. Lors de l’affichage des pics de référence, les 
témoins du traitement par le bisulfite sont identifiés par des losanges 
orange (analyses CpG uniquement). 

 Pour afficher la hauteur d’un pic, placer le pointeur de la souris en haut du 
pic. Une infobulle affiche la hauteur. 

 Lors de l’affichage de l’histogramme, celui-ci apparaît en gris par dessus 
les pics. Il est préférable de l’observer en zoomant. 

Remarque : Il est possible de basculer entre l’affichage et le masquage de 
l’histogramme et des pics de référence en cliquant avec le bouton droit de la 
souris sur le pyrogramme. 

Analyses SQA 
 

 
 

Lors de la sélection d’une base de la séquence d’appel de bases, le pic correspondant est mis 
en surbrillance dans les deux zones du pyrogramme et vice versa. 

Le pyrogramme des analyses SQA utilise les informations et les couleurs 
suivantes : 

 Le nom du puits figure dans le coin supérieur gauche. 

 Pour afficher la hauteur d’un pic, placer le pointeur de la souris en haut du 
pic. Une infobulle affiche la hauteur. 

 Lors de l’affichage de l’histogramme, le pyrogramme compensé apparaît 
en gris par dessus les pics du pyrogramme. Il est préférable de l’observer 
en zoomant. 

 Lors de l’affichage des bases connues, les pics correspondants sont 
identifiés par des losanges bleus sur le pyrogramme.  

 Lors de l’affichage du niveau de pic, le niveau de pic calculé apparaît sur 
le pyrogramme.  
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 Sur le pyrogramme compensé, dans la partie inférieure, les pics sont 
colorés en fonction des évaluations de la qualité (voir la légende des 
couleurs, page 49.) 

Remarque : Il est possible de basculer entre l’affichage et le masquage de 
l’histogramme, des bases connues et du niveau de pic en cliquant avec le 
bouton droit de la souris sur le pyrogramme.  

Zoom du pyrogramme 
Il est possible d’effectuer un zoom avant sur le pyrogramme en sélectionnant 
une section à l’aide du bouton gauche de la souris. 

Pour effectuer un zoom arrière, cliquer avec le bouton droit de la souris sur le 
pyrogramme et sélectionner « Zoom out » dans le menu contextuel pour revenir 
au niveau de zoom précédent ou double-cliquer sur le pyrogramme pour le 
réinitialiser sur 100 %. 

Exportation du pyrogramme sous forme d’image 
Pour copier le pyrogramme dans le presse-papier sous forme d’image, cliquer 
avec le bouton droit de la souris sur le pyrogramme et sélectionner « Copy as 
Image » dans le menu contextuel. Il est possible de coller l’image dans des 
applications qui prennent en charge le format EMF (Enhanced Metafile). 

Sélection de puits 
Pour sélectionner un seul puits, cliquer dessus. 
 

 
 
Pour sélectionner un groupe de puits de forme rectangulaire, par exemple 
A2-A3, B2-B3 et C2-C3 : 

 Appuyer sur le bouton gauche de la souris et le maintenir enfoncé tout en 
faisant glisser le pointeur de la souris du puits A2 au puits C3 ou 

 Sélectionner le puits A2 puis appuyer sur la touche « Shift » (« majuscule ») 
et la maintenir enfoncée tout en sélectionnant le puits C3 ou 

 Sélectionner le puits A2 puis appuyer sur la touche « Shift » (« majuscule ») 
et la maintenir enfoncée tout en appuyant sur la touche fléchée vers la 
droite une fois puis sur la touche fléchée vers le bas deux fois. 
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Pour ajouter des puits à la sélection ci-dessus, par exemple les puits B7 et C7, 
appuyer sur la touche « Ctrl » et la maintenir enfoncée tout en sélectionnant les 
puits. 
 

 
 
Pour désélectionner un puits, appuyer sur la touche « Ctrl » et la maintenir 
enfoncée tout en sélectionnant le puits. 

Remarque : Lorsque plusieurs puits d’une plaque sont sélectionnés, ce sont les 
informations sur le puits encadré en orange (dans l’écran d’analyse) qui sont 
affichées dans la zone « Well Information » (Informations sur le puits). 

Démarrage du logiciel 
Dans le menu « Start » (Démarrer) de Windows, sélectionner « (All) 
Programs/PyroMark/PyroMark Q24 » (Tous les 
programmes/PyroMark/PyroMark Q24). 

Il est possible d’accéder à tout moment au Guide d’utilisation du logiciel 
PyroMark Q24 MDx (le présent document) en appuyant sur la touche « F1 » 
dans le logiciel. 

Configuration d’une analyse AQ ou CpG 

Enchainement des étapes 
 

 
 

1. Cliquer sur  dans la barre d’outils et sélectionner « New AQ 
Assay » (Nouvelle analyse AQ) ou « New CpG Assay » (Nouvelle 
analyse CpG). Un nouveau fichier d’analyse est créé.  

2. Saisir la séquence à analyser (voir page 21). 
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3. Cliquer sur le bouton « Generate Dispensation Order » (Définir 
l’ordre de distribution). Voir page 24. 

4. Facultatif : Lors de la création d’une analyse CpG, renseigner le 
champ « Sequence Before Bisulfite Treatment » (Séquence avant 
traitement par le bisulfite). Cette information est utile en cas d’ajout 
de témoins du traitement par le bisulfite.  

5. Recommandation : Lors de la création d’une analyse CpG, ajouter 
des témoins de traitement par le bisulfite, de préférence en début de 
séquence (voir page 26).  

6. Facultatif : Saisir des informations sur l’analyse dans la zone de texte 
« Assay Note » (Note sur l’analyse).  

7. Facultatif : Configurer les positions variables (voir page 26).  
8. Avant d’analyser les échantillons, valider l’analyse à l’aide d’un 

échantillon d’ADN de référence, voir l’Annexe B du Manuel 
d’utilisation du PyroMark Q24 MDx. 

9. Facultatif : Si cela s’avère nécessaire au cours de la validation de 
l’analyse, modifier les paramètres d’analyse. Voir page 28. 

10. Facultatif : Verrouiller l’analyse pour en empêcher la modification à 
l’aide du bouton « Lock Assay » (Verrouiller l’analyse) situé en bas 
de la fenêtre de configuration de l’analyse. Il est impossible de 
déverrouiller une analyse verrouillée ( ) réalisée sur l’appareil 
PyroMark Q24 MDx. C’est-à-dire qu’il est impossible d’en modifier 
les paramètres ou les résultats une fois l’analyse effectuée. 

 

Remarque : Il est possible de créer un nouveau fichier d’analyse dans le 
navigateur des raccourcis en cliquant avec le bouton droit de la souris sur le 
dossier dans lequel enregistrer le fichier de l’analyse puis en sélectionnant 
« New Assay » suivi du type d’analyse souhaité (choix entre « AQ Assay » 
(Analyse AQ) et « CpG Assay » (Analyse CpG)) dans le menu contextuel. Saisir 
le nom du fichier puis appuyer sur « Enter ». Pour ajouter un raccourci vers un 
dossier ou un lecteur, cliquer sur « Add Folder Shortcut ». 

Remarque : Pour afficher la note sur l’analyse dans une infobulle du 
navigateur de raccourcis, placer le pointeur de la souris sur le fichier d’analyse.  

Remarque : Pour enregistrer le fichier, cliquer sur  dans la barre d’outils. Si le 
fichier n’a encore jamais été enregistré, sélectionner un emplacement et saisir 
le nom de fichier dans la boîte de dialogue qui s’ouvre. 

Saisie de la séquence à analyser 
Saisir ou coller (« Ctrl+V ») la séquence à analyser dans la zone de texte 
« Sequence to Analyze » (Séquence à analyser). Lors de la création d’une analyse 
CpG, saisir la séquence après traitement par le bisulfite. 
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La saisie de la séquence d’ADN dans le logiciel doit obéir aux règles suivantes : 

 Les caractères de saisie autorisés sont A, C, G, T ainsi que les codes 
IUPAC.  

 Les positions variables peuvent être saisies soit sous forme de codes 
IUPAC, soit sous forme de deux bases possibles séparées d’une barre 
oblique, par exemple, C/T.  

 Les InDels doivent être saisies entre crochets, par exemple [AT].  

 La séquence doit contenir au maximum 400 caractères et 100 positions 
variables. 

 Les positions variables impliquant une combinaison de SNP et d’InDels 
doivent être saisies en associant les symboles / ou les codes IUPAC avec [ ]. 
Par exemple, [T/A] ou [W] représente un polymorphisme triallélique dont 
les allèles possible sont T, A ou aucun des deux (délétion). 

 Il n’est pas possible de saisir une combinaison de SNP et de bases fixes au 
sein d’une InDels, par exemple [A/TC]. 

 Les InDels imbriquées ne sont pas prises en charge, par exemple 
[ATT[C]G]. 

Si la séquence à analyser comporte une erreur, un point d’exclamation rouge 
s’affiche à la fin de la zone de texte. Placer le pointeur de la souris sur le point 
d’exclamation pour afficher une infobulle expliquant l’erreur. Le ou les 
caractères posant problème sont indiqués en rouge dans la séquence à 
analyser.  
 

 
 

Comme T/T n’est pas une position variable valable, elle entraîne une erreur « Invalid 
sequence » (Séquence non valide). 

Remarque : Dans le cas d’analyse de schémas de méthylation non classiques, 
par exemple dans le cas où les méthylations de C ne sont pas suivies de G, il 
est possible d’analyser ces schémas en mode AQ. Pour analyser ces schémas 
en mode CpG, saisir plusieurs G supplémentaires dans la zone de texte 
« Sequence to Analyze » et régler la hauteur attendue des G supplémentaires 
sur zéro (0). Voir Réglage de la hauteur des barres de l’histogramme, page  33. 
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Codes IUPAC 
 

Code Description   Code   Description 

A Adénine   W    T ou A  

C Cytosine   S    C ou G  

G Guanine   B    C, T ou G (pas A) 

T Thymine   D    A, T ou G (pas C) 

R Purine (A ou G)   H   A, T ou C (pas G) 

Y Pyrimidine (C ou T)   V    A, C ou G (pas T) 

M C ou A   N    Base quelconque (A, C, G 
ou T) 

K T ou G   
 

 
Remarque : S, B, V et N ne sont pas valables après le traitement par le bisulfite. 

Schémas valables pour une analyse CpG  

Les schémas qui n’existent pas après un traitement par le bisulfite ne sont pas 
valables pour une analyse CpG. Par exemple, GC/TGAC/G n’est pas valable 
car C/TG est un site CpG dans le sens direct et C/G n’existe pas après le 
traitement par le bisulfite.  

Le site CpG et les SNP suivants peuvent être inclus dans une analyse directe : 

 Site CpG : C/TG 

 SNP : A/T, A/G, G/T et A/T/G (c’est-à-dire que C ne peut être inclue). 

Le site CpG et les SNP suivants peuvent être inclus dans une analyse inverse : 

 Site CpG : CG/A 

 SNP : A/T, A/C, C/T et A/T/C (c’est-à-dire que G ne peut pas être inclus). 

Remarque : Le logiciel ne prend pas en charge l’analyse des sites CpG qui 
comprennent une position variable supplémentaire, par exemple A/C/TG. Ce 
type de SNP peut être analysé en saisissant C/TG dans la zone de texte 
« Sequence to Analyze » et ATCG dans la zone de texte « Dispensation Order » 
(Ordre de distribution). Lancer le run comme d’habitude. Après l’analyse des 
sites CpG, passer au mode d’analyse AQ et modifier C/TG en A/C/TG (dans la 
zone de texte « Sequence to Analyze ») puis analyser la position variable. De la 
même manière, C/TG/A peut être analysé en saisissant C/TG dans la zone de 
texte « Sequence to Analyze » et TCGA dans la zone de texte « Dispensation 
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Order ». Après l’analyse des sites CpG, passer au mode d’analyse AQ et 
modifier C/TG en C/TG/A (dans la zone de texte « Sequence to Analyze ») puis 
analyser la position variable. 

Définition de l’ordre de distribution  
L’ordre de distribution pour la séquence à analyser saisie est défini par le 
logiciel en cliquant sur le bouton « Generate Dispensation Order ». L’ordre de 
distribution défini comprend des distributions à blanc afin de s’assurer de 
l’obtention de la séquence correcte.  

Lors de la création d’analyses CpG, l’ordre de distribution doit également 
prévoir des témoins du traitement par le bisulfite. Ces témoins doivent être 
ajoutés manuellement par l’utilisateur, après définition de l’ordre de distribution 
(voir page 26).  

Si nécessaire, il est possible de saisir ou de modifier l’ordre de distribution 
manuellement. 

Remarque : En cliquant sur le bouton « Generate Dispensation Order », tout 
ordre de distribution existant est remplacé. 

Remarque : Lors de la sélection de la position d’une base dans la séquence à 
analyser, la distribution correspondante est mise en évidence par une couleur 
de fond grise et vice versa. 
 

 
 

La flèche sur la séquence à analyser, l’ordre de distribution et l’histogramme indique la 
position du curseur. 

Remarque : Si la dernière position variable de la séquence à analyser est une 
InDel longue, la distribution se poursuit uniquement jusqu’à obtention de 3 pics 
variables et à condition que le critère de 5 pics de référence soit rempli. Pour 
distribuer l’intégralité de l’InDel, ajouter une position variable après l’InDel ou 
modifier l’ordre de distribution manuellement. 
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Remarque : S’il n’est pas possible pour la séquence d’être en phase avant la 
distribution de 32 allèles, la distribution est interrompue. Par exemple, la 
séquence ACTCDDDDG a pour ordre de distribution ACTC car le 
polymorphisme à 4 D entraîne un déphasage sur un trop grand nombre 
d’allèles. 

Avertissements de distribution 

Si un avertissement est associé à l’ordre de distribution, un point d’exclamation 
rouge  s’affiche à la fin de la zone de texte « Dispensation Order ». Il est 
possible de réaliser une analyse avec un avertissement de distribution. 
Toutefois, il est nécessaire d’en tenir compte lors de l’évaluation des résultats. 
Placer le pointeur de la souris sur le point d’exclamation pour afficher une 
infobulle expliquant l’avertissement. 
 

Avertissement Action suggérée 

« Sequence uncertain 
due to lack of terminal 
sequence information. » 
(Incertitude sur la 
séquence due au 
manque d’informations 
sur la séquence 
terminale) 

Le problème peut être résolu soit en saisissant plus 
d’informations sur la séquence, soit en réduisant le 
nombre de distributions. 

« Sequence not in phase 
at the end of the 
dispensations. » 
(Déphasage de la 
séquence à la fin des 
distributions) 

Le problème peut être résolu en modifiant l’ordre 
de distribution (manuellement ou en cliquant sur 
« Generate Dispensation Order ») ou en saisissant 
plus d’informations sur la séquence.  

Remarque : Si le problème persiste, la partie 
déphasée n’est pas analysée. 

« The generated 
dispensation order 
contains less reference 
peaks than required. » 
(Nombre de pics de 
référence de l’ordre de 
distribution défini 
inférieur au nombre 
requis) 

Si possible, saisir plus d’informations sur la 
séquence et augmenter le nombre de distributions. 
Pour obtenir la meilleure évaluation de la qualité 
des résultats possible, il est recommandé de 
prévoir au moins 5 pics de référence avec des 
hauteurs de 1, 2 et 3.  
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Ajout ou suppression de témoins de traitement par le 
bisulfite (analyses CpG) 
 

 
 
Les analyses CpG doivent contenir au moins un témoin interne pour évaluer 
l’efficacité du traitement par le bisulfite, de préférence en début de séquence. 
Les bases C non suivies d’une base G dans la séquence ne sont généralement 
pas méthylées et doivent par conséquent être transformées en T après 
traitement par le bisulfite et PCR. La réussite du traitement est indiquée par la 
présence de T seulement et non pas de C à ces emplacements. Dans le cas des 
analyses inverses, toutes les matrices doivent présenter des A à ces positions et 
pas de G.  

Les positions possibles des témoins du traitement par le bisulfite sont indiquées 
par une lettre orange en gras sur l’histogramme : T pour une analyse directe et 
A pour une analyse inverse. 

Pour ajouter un témoin de traitement par le bisulfite, cliquer avec le bouton 
gauche de la souris sur cette lettre et sélectionner une option dans le menu 
contextuel. Il est également possible d’ajouter un témoin manuellement en 
plaçant un C avant ou après un T dans l’ordre de distribution. 

Pour supprimer un témoin de traitement par le bisulfite, cliquer avec le bouton 
gauche de la souris sur le témoin (C pour une analyse directe, G pour une 
analyse inverse) et sélectionner « Remove Bisulfite Control » (Supprimer le 
témoin bisulfite) dans le menu contextuel. 

Remarque : Dans la séquence avant traitement par le bisulfite, vérifier si les 
témoins bisulfite suggérés sont de type C converties en T (lues comme G et A 
dans l’analyse inverse) et s’ils conviennent comme témoins.  

Configuration des positions variables 
Les positions variables sont configurables dans l’onglet « Variable positions ». 
Les pa ramètres disponibles sont énumérés ci-dessous.  

Remarque : En cas de modification de la séquence à analyser (et de la 
définition d’un nouvel ordre de distribution), les paramètres des positions 
variables reprennent leur valeur par défaut. 
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« Position » Emplacement de la position variable dans la 
séquence à analyser, en comptant de gauche à 
droite 

« Name » (Nom) Nom de la position variable. Pour modifier le nom, 
sélectionner la zone de texte (le contenu est alors mis 
en surbrillance) ou double-cliquer dessus. 

« Type » Type de position variable : SNP, InDel ou site CpG 

« Analyze » (Analyser) La position variable est analysée si cette option est 
cochée.  

Remarque : Cette option n’est pas disponible pour 
les positions variables impossibles à analyser dans le 
mode d’analyse actif. 

« Methylation ranges » 
(Plages de 
méthylation), analyses 
CpG uniquement 

Méthylation attendue des sites CpG. La définition du 
paramètre pour tous les sites CpG permet une 
identification aisée, dans les résultats d’analyse, des 
sites situés en dehors de la plage attendue.  

 La zone vert clair est inférieure à la plage 
attendue. 

 La zone verte se trouve dans la plage attendue.  

 La zone vert foncé est supérieure à la plage 
attendue. 

Remarque : Il est impossible de définir la 
méthylation attendue des sites CpG pour lesquels 
l’option « Analyze » n’est pas cochée. 

Il est possible de décaler la plage attendue vers la 
gauche ou vers la droite en maintenant le bouton 
gauche de la souris enfoncé tout en déplaçant la 
zone avec la souris.  

Les flèches servent à augmenter ou réduire la plage 
attendue. L’étendue de la plage peut également être 
modifiée comme suit : 

1. Placer le pointeur de la souris sur l’extrémité 
gauche ou droite de la zone verte, de manière à ce 
que le pointeur passe d’une flèche blanche au 
symbole  

2. Déplacer la souris vers la gauche ou vers la droite 
en maintenant le bouton gauche de la souris 
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enfoncé. 

Pour modifier l’ensemble des plages de méthylation 
d’un coup, maintenir la touche « Shift » 
(« majuscule ») enfoncée tout en modifiant l’une des 
plages. 

 
Exemples de plages de méthylation 

  
1. Méthylation attendue = 100 % 
2. Méthylation attendue = 0 à 100 % 
3. Méthylation attendue = 30 à 70 % (valeur par 
défaut) 
4. Méthylation attendue = 0 % 

 
Pour rétablir les valeurs par défaut des paramètres des onglets « Variable 
Positions » (Positions Variables) et « Analysis Parameters » (Paramètres 
d’analyse), cliquer sur « Revert to Default » (Rétablir les valeurs par défaut). 

Modification des paramètres d’analyse 
Les paramètres d’analyse par défaut ont été définis pour fournir des résultats 
optimaux pour la plupart des analyses. Si cela s’avère nécessaire au cours de la 
validation de l’analyse, modifier les paramètres d’analyse pour tenter 
d’améliorer les résultats. 

 Modifier les paramètres d’analyse dans l’onglet « Analysis Parameters », 
voir ci-dessous. 

 Activer ou désactiver les pics de référence et les témoins du traitement par 
le bisulfite (analyses CpG uniquement), voir page 32. 

 Régler la hauteur des barres de l’histogramme, voir page 33. 

 Pour activer ou désactiver l’analyse des positions variables et/ou modifier 
les plages de méthylation attendues (analyses CpG uniquement), voir 
Configuration des positions variables, page 26. 

Veiller à valider les modifications, voir l’Annexe B du Manuel d’utilisation du 
PyroMark Q24 MDx. 
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Remarque : Lors de l’utilisation des kits QIAGEN, utiliser les paramètres 
indiqués dans le manuel correspondant. 

Remarque : Toutes les modifications validées sont consignées dans un journal. 
Pour afficher le journal des modifications d’une analyse, ouvrir le fichier 
d’analyse et cliquer sur « Show Change Log » (Afficher le journal des 
modifications). 

Modification des paramètres d’analyse dans l’onglet « Analysis 
Parameters » 

Les paramètres d’analyse suivants sont modifiables dans l’onglet « Analysis 
Parameters ».  
 

« Unsuccessful 
bisulfite treatment » 
(Échec du traitement 
par le bisulfite), 
analyses CpG 
uniquement 

Ces paramètres indiquent le pourcentage maximal 
autorisé de séquence non transformée pour atteindre 
le critère de qualité « Passed » (Succès) et le critère 
« Check » (À vérifier) pour les sites CpG. Les valeurs 
saisies sont comparées aux valeurs de hauteur de pic 
mononucléotidique déterminées par l’algorithme 
d’analyse. 

« Allowed percentage 
for passed quality » 
(Pourcentage autorisé 
pour atteindre le critère 
de qualité « Passed ») 

Pourcentage maximal autorisé de séquence non 
transformée pour atteindre le critère de qualité 
« Passed » pour les sites CpG. 

La valeur par défaut est de 5 %.  

Remarque : La valeur ne peut pas être supérieure à 
celle du paramètre « Allowed percentage for check 
quality » (Pourcentage autorisé pour atteindre le 
critère de qualité « Check »), voir ci-dessous. 
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« Allowed percentage 
for check quality » 

Pourcentage maximal autorisé de séquence non 
transformée pour atteindre le critère de qualité 
« Check » pour les sites CpG. L’avertissement 
« Uncertain bisulfite conversion at dispensation: » 
(Incertitude de transformation par le bisulfite à la 
distribution) suivi d’un ou plusieurs numéros est 
déclenché pendant l’analyse.  

Remarque : Cette règle s’applique uniquement si le 
critère de qualité « Passed » n’est pas satisfait. 

Un pourcentage de séquence non transformée plus 
élevé que la valeur définie se traduit par une 
évaluation de la qualité « Failed » (Échec) pour tous 
les sites CpG. L’avertissement « Failed bisulfite 
conversion at dispensation: » (Échec de la 
transformation par le bisulfite à la distribution) suivi 
d’un nombre est déclenché pendant l’analyse. 

La valeur par défaut est de 7 %.  

Remarque : La valeur ne peut pas être inférieure à 
celle du paramètre « Allowed percentage for passed 
quality », voir ci-dessus. 

« Peak height 
threshold » (Seuil de 
la hauteur de pic) 

Ces paramètres définissent la limite inférieure de 
l’intensité du niveau de pic mononucléotidique au 
début du pyrogramme. 

« Required peak height 
for passed quality » 
(Hauteur de pic exigée 
pour atteindre le critère 
de qualité « Passed ») 

Intensité minimale du signal pour qu’un pic atteigne 
le critère de qualité « Passed » pour les positions 
variables. 

La valeur par défaut est de 20. 

Remarque : La valeur ne peut pas être inférieure à 
celle du paramètre « Required peak height for check 
quality » (Hauteur de pic exigée pour atteindre le 
critère de qualité « Check »), voir ci-dessous. 
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« Required peak height 
for check quality » 

Intensité minimale du signal pour qu’un pic atteigne 
le critère de qualité « Check » pour les positions 
variables. L’avertissement « Uncertain due to low 
peak height » (Incertitude due à une hauteur de pic 
faible) est déclenché pendant l’analyse. 

Remarque : Cette règle s’applique uniquement si le 
critère de qualité « Passed » n’est pas satisfait. 

La valeur par défaut est de 10. 

Une intensité du signal d’un pic inférieure à la valeur 
définie se traduit par une évaluation de la qualité 
« Failed » pour les positions variables. 
L’avertissement « Failed due to low peak height » 
(Échec dû à une hauteur de pic faible) est déclenché 
pendant l’analyse. 

Remarque : La valeur ne peut pas être supérieure à 
celle du paramètre « Required peak height for passed 
quality », voir ci-dessus. 

« Stringency levels » 
(Niveaux de rigueur) 

La rigueur des avertissements « Pattern deviation in 
variable positions » (Écart du tracé pour les positions 
variables) et « Sum deviation in variable positions » 
(Écart de la somme pour les positions variables) peut 
être définie sur « Low » (Faible), « Normal » 
(Normale, valeur par défaut) et « High » (Élevée). Un 
niveau de rigueur élevé réduit l’écart autorisé. 

« Pattern deviation in 
variable positions »  

Écart entre le tracé de pic mesuré pour une position 
variable et le tracé théorique. 

Si l’écart est supérieur au niveau de rigueur défini, 
l’avertissement « Uncertain/Failed due to high pattern 
deviation in variable position » (Incertitude/Échec dus 
à un écart important du tracé pour la position 
variable) est déclenché pendant l’analyse. 
L’obtention du résultat de qualité « Check » ou 
« Failed » pour l’analyse dépend de l’ampleur de 
l’écart. 
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« Sum deviation in 
variable positions » 

Écart entre la somme de tous les pics mesurée pour 
une position variable et la somme théorique 
(déterminée d’après la hauteur de pic 
mononucléotidique). 

Si l’écart est supérieur au niveau de rigueur défini, 
l’avertissement « Uncertain/Failed due to high sum 
deviation in variable position » (Incertitude/Échec dus 
à un écart important de la somme pour la position 
variable) est déclenché pendant l’analyse. 
L’obtention du résultat de qualité « Check » ou 
« Failed » pour l’analyse dépend de l’ampleur de 
l’écart. 

« Parameters » 
Paramètres 

 

« A-peak reduction 
factor » (Facteur de 
compression du pic de 
A) 

Facteur par lequel les intensités du pic de A sont 
multipliées pour tenir compte du fait que les pics de 
A sont plus hauts que les autres pics.  

La valeur par défaut est de 0,90.  
 
Pour rétablir les valeurs par défaut des paramètres des onglets « Variable 
Positions » et « Analysis Parameters », cliquer sur « Revert to Default ». 

Activation et désactivation des pics de référence et des témoins du 
traitement par le bisulfite  

Les pics invariables, c’est-à-dire les pics ne représentant pas une position 
variable (y compris les distributions à blanc) sont appelés « pics de référence ». 
Les pics de référence servent à la fois de référence au calcul du niveau de pic 
mononucléotidique et de témoins internes lors de l’évaluation de la qualité. 
Pour obtenir la meilleure évaluation de la qualité des résultats possible, il est 
recommandé de laisser les pics de référence générés par le logiciel activés. 

Un pic de référence est activé ou désactivé, selon son état précédent, en 
cliquant avec le bouton gauche de la souris sur le losange situé au-dessus du 
pic concerné sur l’histogramme. Le losange affiche l’état : 

 Losange bleu plein : pic de référence activé. 

 Losange bleu vide : pic de référence désactivé. 

Pour les analyses CpG uniquement : Un témoin de traitement par le bisulfite est 
activé ou désactivé et/ou défini ou non comme pic de référence, selon son état 
précédent, en cliquant avec le bouton gauche de la souris sur le losange de 
témoin de traitement sur l’histogramme. Le losange affiche l’état : 
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 Losange orange plein : témoin de traitement par le bisulfite et pic de 
référence activés. 

 Losange bleu plein : pic de référence activé mais témoin de traitement par 
le bisulfite désactivé. 

 Losange orange vide : témoin de traitement par le bisulfite et pic de 
référence désactivés. 

Placer le pointeur de la souris sur le losange pour afficher une infobulle 
expliquant l’action d’un clic. 

Remarque : Pour basculer entre l’affichage et le masquage des pics de 
référence sur l’histogramme, cliquer avec le bouton droit de la souris sur 
l’histogramme et sélectionner « Show Reference Peaks » (Afficher les pics de 
référence) dans le menu contextuel. 

Réglage de la hauteur des barres de l’histogramme 

Cette fonctionnalité est utile lorsque l’expérience a permis d’observer un écart 
reproductible du tracé mesuré par rapport au tracé théorique. Utiliser cette 
fonction avec précaution. 

1. Appuyer sur la touche « Ctrl » et la maintenir enfoncée tout en 
cliquant avec le bouton gauche de la souris en haut de la barre de 
l’histogramme (cliquer lorsque le pointeur passe de la flèche blanche 
au symbole ). 

2. Saisir la hauteur dans la zone de texte qui s’ouvre ou augmenter ou 
diminuer la valeur à l’aide des flèches situées à côté de la zone de 
texte.  

3. Pour valider la nouvelle valeur, appuyer sur « Enter ». 
Remarque : Au lieu de supprimer les tracés de méthylation non classiques de 
la séquence à analyser, par exemple dans le cas où les méthylations de C ne 
sont pas suivies de G, régler la hauteur attendue pour G sur zéro (0). 
 

 

 
 

Orange clair = diminution de la hauteur 
Orange foncé = augmentation de la hauteur 
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Configuration d’une analyse SQA 

Enchainement des étapes 
 

 
 

1. Cliquer sur  dans la barre d’outils puis sélectionner « New SQA 
Assay » (Nouvelle analyse SQA). Un nouveau fichier d’analyse est 
créé.  

2. Renseigner le champ « Dispensation Order », voir page 35. 
3. Facultatif : Saisir des informations sur l’analyse dans la zone de texte 

« Assay Note ».  
4. Avant d’analyser les échantillons, valider l’analyse à l’aide d’un 

échantillon d’ADN de référence, voir l’Annexe B du Manuel 
d’utilisation du PyroMark Q24 MDx. 

5. Facultatif : Si cela s’avère nécessaire au cours de la validation de 
l’analyse, modifier les paramètres d’analyse. Voir page 35. 

6. Facultatif : Verrouiller l’analyse pour en empêcher la modification à 
l’aide du bouton « Lock Assay » situé en bas de la fenêtre de 
configuration de l’analyse. Il est impossible de déverrouiller une 
analyse verrouillée ( ) réalisée sur l’appareil PyroMark Q24 MDx. 
C’est-à-dire qu’il est impossible d’en modifier les paramètres ou les 
résultats une fois l’analyse effectuée. 

 

Remarque : Il est possible de créer un nouveau fichier d’analyse dans le 
navigateur des raccourcis en cliquant avec le bouton droit de la souris sur le 
dossier dans lequel enregistrer le fichier de l’analyse puis en sélectionnant 
« New Assay » suivi du type d’analyse souhaité dans le menu contextuel. Saisir 
le nom du fichier puis appuyer sur « Enter ». Pour ajouter un raccourci vers un 
dossier ou un lecteur, cliquer sur « Add Folder Shortcut ». 

Remarque : Pour afficher la note sur l’analyse dans une infobulle du 
navigateur de raccourcis, placer le pointeur de la souris sur le fichier d’analyse.  

Remarque : Pour enregistrer le fichier, cliquer sur  dans la barre d’outils. Si le 
fichier n’a encore jamais été enregistré, sélectionner un emplacement et saisir 
le nom de fichier dans la boîte de dialogue qui s’ouvre. 

34 Guide d’utilisation du logiciel PyroMark Q24 MDx   05/2010 



 

Saisie de l’ordre de distribution 
Saisir ou coller (« Ctrl+V ») l’ordre de distribution dans la zone de texte 
« Dispensation Order ». La saisie de l’ordre de distribution dans le logiciel doit 
obéir aux règles suivantes : 

 Les caractères de saisie autorisés sont A, C, G et T.  

 Pour répéter un groupe de bases, utiliser des chiffres et des parenthèses, 
par exemple, « 3(CTGA) » correspond à « CTGACTGACTGA ». 

Si l’ordre de distribution comporte une erreur, un point d’exclamation rouge 
s’affiche à la fin de la zone de texte. Placer le pointeur de la souris sur le point 
d’exclamation pour afficher une infobulle expliquant l’erreur. Le ou les 
caractères posant problème sont indiqués en rouge dans l’ordre de distribution.  
 

 
 

L’erreur « The entered dispensation order is not complete » (Ordre de distribution saisi 
incomplet) est due à une parenthèse manquante ou mal placée. Dans cet exemple, il manque 
une parenthèse fermante. 

Modification des paramètres d’analyse 
Les paramètres d’analyse par défaut ont été définis pour fournir des résultats 
optimaux pour la plupart des analyses. Si cela s’avère nécessaire au cours de la 
validation de l’analyse, modifier les paramètres d’analyse pour tenter 
d’améliorer les résultats. 

 La valeur par défaut du paramètre « Quality Control Window » (Plage de 
contrôle qualité) de l’onglet « Settings » (Paramètres) est de 20. Si un 
nombre différent de bases est nécessaire, modifier la valeur en 
conséquence. 

 Modifier les paramètres d’analyse dans l’onglet « Analysis Parameters », 
voir ci-dessous. 

Veiller à valider les modifications, voir l’Annexe B du Manuel d’utilisation du 
PyroMark Q24 MDx. 

Remarque : Lors de l’utilisation des kits QIAGEN, utiliser les paramètres 
indiqués dans le manuel correspondant. 

Remarque : Toutes les modifications validées sont consignées dans un journal. 
Pour afficher le journal des modifications d’une analyse, ouvrir le fichier 
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d’analyse et cliquer sur « Show Change Log » en bas de la fenêtre de 
configuration de l’analyse. 

Modification des paramètres d’analyse dans l’onglet « Analysis 
Parameters » 

Les paramètres d’analyse suivants sont modifiables dans l’onglet « Analysis 
Parameters ».  
 

« Peak height 
threshold » 

Ces paramètres définissent la limite inférieure de 
l’intensité du niveau de pic mononucléotidique au 
début du pyrogramme. 

« Required peak height 
for passed quality » 

Intensité minimale du signal pour qu’un pic atteigne 
le critère de qualité « Passed » pour la séquence 
d’appel de bases. 

La valeur par défaut est de 10. 

Remarque : La valeur ne peut pas être inférieure à 
celle du paramètre « Required peak height for check 
quality », voir ci-dessous. 

« Required peak height 
for check quality » 

Intensité minimale du signal pour qu’un pic atteigne 
le critère de qualité « Check » pour la séquence 
déterminée par appel de bases. L’avertissement 
« Uncertain due to low peak height » est déclenché 
pendant l’analyse. 

Remarque : Cette règle s’applique uniquement si le 
critère de qualité « Passed » n’est pas satisfait. 

La valeur par défaut est de 5. 

Une intensité du signal d’un pic inférieure à la valeur 
définie se traduit par une évaluation de la qualité 
« Failed ». L’avertissement « Failed due to low peak 
height » est déclenché pendant l’analyse. 

Remarque : La valeur ne peut pas être supérieure à 
celle du paramètre « Required peak height for passed 
quality », voir ci-dessus. 

« Parameters »    
Paramètres 

 

« A-peak reduction 
factor » 

Facteur par lequel les intensités du pic de A sont 
multipliées pour tenir compte du fait que les pics de 
A sont plus hauts que les autres pics.  

La valeur par défaut est de 0,90. 
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« Plus shift 
compensation » 
(Compensation du 
décalage positif) 

Si cette option est cochée, une compensation des pics 
est appliquée pour cause de décalage positif. 

« Minus shift 
compensation » 
(Compensation du 
décalage négatif) 

Si cette option est cochée, une compensation des pics 
est appliquée pour cause de décalage négatif. 

« Stringent 
homopolymer 
scoring » (Évaluation 
stricte des 
homopolymères) 

Si cette option est cochée, des règles d’évaluation de 
la qualité plus strictes s’appliquent aux 
homopolymères. L’avertissement « Peak height 
deviates from the expected peak level at 
dispensation: » (Écart de la hauteur de pic par 
rapport au niveau de pic attendu à la distribution) 
suivi d’un nombre est déclenché pendant l’analyse.  

« Known bases » 
(Bases connues) 

Si l’ordre de distribution comporte des bases 
connues, il est recommandé de saisir celles-ci afin 
d’améliorer les résultats d’analyse.  

1. Cliquer avec le bouton gauche de la souris sur 
l’ordre de distribution puis saisir la hauteur dans la 
zone de texte qui s’ouvre ou augmenter ou 
diminuer la valeur à l’aide des flèches situées à 
côté de la zone de texte.  

2. Pour valider la valeur, appuyer sur « Enter ». 
 
Pour rétablir les valeurs par défaut des paramètres des onglets « Settings » et 
« Analysis Parameters », cliquer sur « Revert to Default ». 

Configuration d’un run 

Enchainement des étapes 
1. Cliquer sur  dans la barre d’outils. Un nouveau fichier de run est 

créé. 
2. Saisir les paramètres du run (voir page 38). 
3. Configurer une plaque (c’est-à-dire ajouter une analyse et, si besoin, 

saisir un ID d’échantillon et une note pour chaque puits utilisé). Voir 
page 39. 

4. Une fois le run configuré et prêt à être lancé sur l’appareil PyroMark 
Q24 MDx : 
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Pour imprimer la configuration de la plaque et la liste des volumes de 
réactifs requis de mélange d’enzymes, de mélange de substrats et de 
nucléotides, sélectionner « Pre Run Information » dans le menu « Tools » 
puis, lorsque le rapport s’affiche, cliquer sur . 

Fermer le fichier de run et, à l’aide de Windows Explorer, le copier sur l’une 
des clés USB fournies avec le système. Pour lancer Windows Explorer, 
cliquer avec le bouton droit de la souris sur le dossier contenant le fichier 
de run dans le navigateur des raccourcis puis sélectionner « Explore » dans 
le menu contextuel. Pour plus d’informations, appuyer sur la touche « F1 » 
afin d’ouvrir l’aide en ligne de Windows. 

Pour le traitement d’une plaque sur l’appareil PyroMark Q24 MDx, voir 
page 45. 

Remarque : Pour imprimer le rapport « Pre-Run Information » en couleur, 
activer l’option « Print background colors and images » d’Internet Explorer dans 
« Tools/Internet Options/Advanced/Printing ». 

Remarque : Il est possible de créer un nouveau fichier de run dans le 
navigateur des raccourcis en cliquant avec le bouton droit de la souris sur le 
dossier souhaité puis en sélectionnant « New Run » dans le menu contextuel. 
Saisir le nom du fichier puis appuyer sur « Enter ». Pour ajouter un raccourci 
vers un dossier ou un lecteur, cliquer sur « Add Folder Shortcut ». 

Remarque : Pour réaliser un run inspiré d’un run précédent, cliquer avec le 
bouton droit de la souris sur le fichier de run traité dans le navigateur de 
raccourcis et sélectionner « Copy and Rerun » dans le menu contextuel. Seules 
les données de configuration du  run sont copiées, pas les données du run ni 
de son analyse. 

Remarque : Pour enregistrer le fichier, cliquer sur  dans la barre d’outils. Si le 
fichier n’a encore jamais été enregistré, sélectionner un emplacement et saisir 
le nom de fichier dans la boîte de dialogue qui s’ouvre. 

Saisie des paramètres du run 
Les paramètres de run suivants sont disponibles. 
 

« Run name » (Nom du 
run) 

Nom du run donné au moment de l’enregistrement 
du fichier. Le fait de renommer le fichier modifie 
également le nom du run. 

« Instrument method » 
(Méthode de 
l’appareil) 

Sélectionner la méthode de l’appareil en fonction des 
réactifs et de la cartouche utilisés pour le run (voir 
Gestion des méthodes de l’appareil, page 63). 

Remarque : Il est recommandé d’utiliser uniquement 
les méthodes fournies par QIAGEN. 
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« Plate ID » (ID de 
plaque) 

Facultatif : Saisir l’ID de la plaque PyroMark Q24.  

Remarque : Lorsque le pointeur de la souris est 
placé sur un fichier de run dans le navigateur des 
raccourcis, une infobulle affiche l’ID de plaque saisi. 

« Barcode » (Code-
barres) 

Facultatif : Saisir un code-barres pour la plaque ou, 
si un lecteur de codes-barres est relié à l’ordinateur, 
placer le curseur de la souris sur la zone de texte 
« Barcode » et scanner le code-barres.  

« Reagent ID » (ID de 
réactif) 

Facultatif : Saisir le numéro de lot des réactifs 
PyroMark Gold Q24 à utiliser. Ce numéro se trouve 
sur l’étiquette du produit. 

Remarque : Il est recommandé de saisir les ID de 
réactif de manière à assurer la traçabilité des réactifs 
en cas de problème. 

« Estimated run time » 
(Temps de run estimé) 

Temps de run estimé. 

« Run note » (Note sur 
le run) 

Facultatif : Saisir une note sur le contenu ou 
l’objectif du run. 

Ajout de fichiers d’analyse pour une plaque 
Il existe deux façons d’ajouter une analyse à un puits : 

 Sélectionner l’analyse dans le navigateur des raccourcis puis appuyer sur le 
bouton gauche de la souris et le maintenir enfoncé tout en faisant glisser 
l’analyse sur le puits. 

 Cliquer avec le bouton droit de la souris sur le puits et sélectionner « Load 
Assay » (Charger l’analyse) dans le menu contextuel. 

Remarque : Pour ajouter une analyse à plusieurs puits, sélectionner les puits 
(voir Sélection de puits, page 19) puis faire glisser l’analyse sur la sélection. 

Remarque : Il est impossible d’ajouter une analyse sans ordre de distribution ou 
d’ajouter deux analyses ou plus ayant le même nom mais des ordres de 
distribution différents. 
 

 
 

Le puits prend la couleur de l’analyse qui lui est associée. 
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Saisie des ID d’échantillons et des notes 
 Pour saisir un ID d’échantillon ou une note, sélectionner la cellule (voir 

image ci-dessous) et saisir le texte. 

 Pour modifier un ID d’échantillon ou une note, sélectionner la cellule (le 
contenu est alors mis en surbrillance) ou double-cliquer dessus. 

 Pour importer un agencement d’échantillons et de notes défini dans un 
fichier texte (*.tsv ou *.csv), cliquer avec le bouton droit de la souris sur un 
puits et sélectionner « Insert Sample Layout File » (Insérer un fichier 
d’agencement d’échantillons) dans le menu contextuel. Pour plus 
d’informations, voir Définition d’un ID d’échantillon et d’une note en dehors 
du logiciel, page 42. 

 Pour coller l’agencement d’échantillons à partir du presse-papier, cliquer 
avec le bouton droit de la souris sur le puits et sélectionner « Paste Sample 
Layout » (Coller l’agencement d’échantillons) dans le menu contextuel. Pour 
plus d’informations, voir Définition d’un ID d’échantillon et d’une note en 
dehors du logiciel, page 42. 

Remarque : Les virgules et les points-virgules ne sont pas pris en charge. 
 

 

 
La couleur de fond d’une cellule sélectionnée est le bleu. 

Copie ou suppression du contenu des cellules 
 Pour couper le contenu d’une cellule et le placer dans le presse-papier, 

cliquer avec le bouton droit de la souris sur la cellule puis sélectionner 
« Cut » (Couper) dans le menu contextuel. 

 Pour copier le contenu d’une cellule et le placer dans le presse-papier, 
cliquer avec le bouton droit de la souris sur la cellule puis sélectionner 
« Copy Cell » (Copier la cellule) dans le menu contextuel ou sélectionner la 
cellule et appuyer sur « Ctrl+C ». 

 Pour coller le contenu du presse-papier dans une cellule ou une sélection 
de cellules (voir Sélection de puits, page 19), cliquer avec le bouton droit 
de la souris sur la cellule ou la sélection et sélectionner « Paste » (Coller) 
dans le menu contextuel ou sélectionner la ou les cellules et appuyer sur 
« Ctrl+V ». 

 Pour supprimer des analyses, des ID d’échantillons ou des notes, cliquer 
avec le bouton droit de la souris sur la cellule ou une sélection de cellules 
et sélectionner « Delete » (Supprimer) dans le menu contextuel ou 
sélectionner la ou les cellules et appuyer sur « Delete ». 
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Copier-déplacer du contenu d’une cellule vers d’autres puits 

Pour copier-déplacer le contenu d’une cellule vers d’autres puits : 

1. Sélectionner la cellule à copier. 
2. Placer le pointeur de la souris sur le coin inférieur droit de la zone 

sélectionnée puis appuyer sur le bouton gauche de la souris et le 
maintenir enfoncé tout en déplaçant la souris pour modifier la 
sélection. 

3. Lorsque le bouton gauche de la souris est relâché, le contenu de la 
première cellule sélectionnée est collé dans les autres cellules 
sélectionnées. 

 

 
 

Copier-déplacer de la note « 25 μl PCR prod ». 

Copier-déplacer et incrément de l’ID d’échantillon 

Un ID d’échantillon se termine par un chiffre qu’il est possible d’incrémenter 
lors d’un copier-déplacer de l’ID : 

1. Sélectionner la cellule de l’ID d’échantillon. 
2. Pour incrémenter par ligne :  

Placer le pointeur de la souris sur le coin inférieur droit de la zone 
sélectionnée. 

Appuyer sur la touche « Ctrl » et le bouton gauche de la souris et les 
maintenir enfoncés tout en déplaçant la souris pour modifier la sélection. 

Relâcher en premier le bouton de la souris puis la touche « Ctrl ». Lorsque 
le bouton gauche de la souris est relâché, l’ID d’échantillon de la première 
cellule sélectionnée est incrémenté et collé dans les autres cellules 
sélectionnées. 

3. Pour incrémenter par colonne : 
Placer le pointeur de la souris sur le coin inférieur droit de la zone 
sélectionnée. 

Appuyer sur les touches « Shift » (« majuscule ») et « Ctrl » ainsi que le 
bouton gauche de la souris et les maintenir enfoncés tout en déplaçant la 
souris pour modifier la sélection. 

Relâcher en premier le bouton de la souris puis les touches « Shift » 
(« majuscule ») et « Ctrl ». Lorsque le bouton gauche de la souris est 
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relâché, l’ID d’échantillon de la première cellule sélectionnée est 
incrémenté et collé dans les autres cellules sélectionnées. 

 

 
 

L’ID d’échantillon « Sample 1 » est copié et incrémenté par colonne. 

Impression et exportation de la configuration d’une plaque 
sous forme d’image 
Pour imprimer la configuration de la plaque ou la copier dans le presse-papier 
sous forme d’image, cliquer avec le bouton droit de la souris sur la plaque et 
sélectionner « Print » (Imprimer) ou « Copy as Image » dans le menu contextuel. 
Il est possible de coller l’image dans des applications qui prennent en charge le 
format EMF (Enhanced Metafile). 

Définition d’un ID d’échantillon et d’une note en dehors du 
logiciel 
Les fonctions « Import/Insert Sample Layout File » (Importer/Insérer un fichier 
d’agencement d’échantillons) et « Paste Sample Layout » permettent d’utiliser 
facilement le même agencement pour plusieurs runs et d’exploiter les 
informations existantes.  

Utilisation de la fonction « Import/Insert Sample Layout File »  

Il est possible, par exemple, de générer des fichiers d’agencement 
d’échantillons et de notes depuis un système de gestion de l’information des 
laboratoires (SGIL). Il est également possible de créer des fichiers 
d’agencement dans Microsoft Excel, Notepad ou autre application similaire. Le 
fichier doit comporter deux ou trois colonnes nommées « Well » (Puits), 
« Sample ID » (ID d’échantillon) et « Note » (facultatif). Les colonnes doivent être 
séparées par une tabulation, une virgule ou un point-virgule et chaque ligne 
doit être délimitée par un saut de ligne. Enregistrer le fichier sous forme de 
fichier texte à valeurs séparées par des tabulations ou par des virgules (*.tsv, 
*.txt ou *.csv). 
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Le fichier d’agencement des échantillons et des notes peut être importé dans : 

 un fichier de run existant en cliquant avec le bouton droit de la souris sur 
un puits dans « Plate Setup » (Configuration de la plaque) et en 
sélectionnant « Insert Sample Layout File » dans le menu contextuel. 

 un nouveau fichier de run en sélectionnant « Import » suivi de « Create 
New Run from Sample Layout File » dans le menu « File » (Fichier). 

 
 

 
 

Exemple de fichier d’agencement d’échantillons et de notes créé dans Microsoft Excel. 
 

 
 

Résultat après importation du fichier d’agencement d’échantillons et de notes ci-dessus. 

Utilisation de la fonction « Paste sample Layout »  

Il est possible, par exemple, de générer et de copier des agencements depuis 
un SGIL. Les agencements d’échantillons peuvent être copiés de Microsoft Excel, 
Word, Notepad (Bloc-notes) et d’autres applications similaires. Dans le fichier 
source, les colonnes d’ID d’échantillon doivent être séparées par une tabulation 
et chaque ligne doit être délimitée par un saut de ligne. 

Pour coller un agencement d’échantillons dans un fichier de run existant : 

1. Copier l’ensemble des informations du fichier source. 
2. Cliquer avec le bouton droit de la souris sur un puits dans « Plate 

Setup » et sélectionner « Paste Sample Layout » dans le menu 
contextuel. 

Le logiciel colle les ID d’échantillon sur la plaque, en commençant par le puits 
A1. (Si des notes ont été saisies pour les puits, elles sont conservées.) 
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Exemple d’agencement d’échantillons créé dans Microsoft Notepad (Bloc-notes). 
 

 
 

Résultat après copier-coller de l’agencement d’échantillons créé dans Microsoft Notepad 
(Bloc-notes). 

Révision de la configuration d’une plaque 
La zone « Well Information » fournit les renseignements suivants sur un puits 
sélectionné dans « Plate Setup ». 

 Nom du puits 

 Type d’analyse (AQ, CpG ou SQA) 

 Nom de l’analyse 

 ID d’échantillon (si renseigné) 

 Séquence à analyser (analyses AQ et CpG uniquement) 

 Ordre de distribution 

 Note sur le puits (si renseignée) 

Lorsque plusieurs puits d’une plaque sont sélectionnés, ce sont les informations 
du premier puits sélectionné qui sont affichées. 
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Traitement d’un run sur l’appareil PyroMark Q24 
MDx 

Enchainement des étapes 
Une fois un run configuré et prêt à être traité sur l’appareil PyroMark Q24 MDx, 
procéder comme suit : 

1. Préparer les échantillons. 
2. Remplir la cartouche PyroMark Q24 avec les volumes adéquats de 

réactifs. 
3. Charger la cartouche de réactifs et la plaque PyroMark Q24 sur 

l’appareil. 
4. Introduire la clé USB contenant le fichier de run dans le port USB à 

l’avant de l’appareil. 
5. Sélectionner le fichier du run puis lancer le run. 
6. Une fois le run terminé et les données transférées sur la clé USB, 

retirer celle-ci. 
7. Décharger la plaque et la cartouche de réactifs. 
Pour plus d’informations, voir la Section 5.5 du Manuel d’utilisation du 
PyroMark Q24 MDx. 
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Analyse du run 

Enchainement des étapes  
1. Transférer le fichier de run traité de la clé USB sur un ordinateur 

exécutant le logiciel PyroMark Q24 MDx en insérant la clé dans le 
port USB de l’ordinateur et en déplaçant le fichier à l’emplacement 
souhaité avec Windows Explorer.  

2. Ouvrir le fichier de run dans le logiciel PyroMark Q24 MDx en 
sélectionnant « Open » dans le menu « File » ou en double-cliquant 
dessus ( ) dans le navigateur des raccourcis. Si le run comprend 
plusieurs types d’analyse, choisir le mode d’analyse dans la boîte de 
dialogue qui s’affiche.  
Remarque : Pour mettre à jour le contenu d’un dossier dans le navigateur 
des raccourcis, cliquer avec le bouton droit de la souris sur ce dossier puis 
sélectionner « Refresh » dans le menu contextuel. 

Remarque : Il est également possible d’ouvrir le fichier de run en double-
cliquant dessus dans Windows Explorer. 

3. Analyser le run (voir ci-dessous). 
4. Afficher les résultats d’analyse (voir page 47). 
5. Facultatif : Si nécessaire, modifier le déroulement de l’analyse (voir 

page 51). 
6. Facultatif : Saisir une note d’analyse dans la zone de texte « Note » 

de l’onglet « Overview » (Vue d’ensemble).  
Remarque : Pour développer ou minimiser le champ « Note », cliquer sur 
« + » ou « - ». 

7. Pour enregistrer les résultats d’analyse, cliquer sur  dans la barre 
d’outils. 

Remarque : Il est impossible de modifier les paramètres d’analyse et de saisir 
une note d’analyse pour les analyses verrouillées ( ). 

Analyse de tous les puits ou d’une sélection de puits 
Il y a deux façons de procéder à l’analyse dans l’onglet « Overview » : 
 

 Analyser la totalité des puits avec une configuration d’analyse 
valide pour le mode d’analyse actif. 

 Analyser une sélection de puits (voir Sélection de puits, page 19).  

Remarque : Il est également possible de cliquer avec le bouton 
droit de la souris sur une sélection puis de choisir « Analyze 
Selected » (Analyser sélection) dans le menu contextuel. 
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Pendant l’analyse, une boîte de dialogue contenant une barre de progression, 
un bouton d’arrêt et le nom du puits en cours d’analyse affiche la progression. 
Pour arrêter l’analyse, cliquer sur « Stop ».  

Remarque : Après analyse d’un puits, celui-ci prend la couleur bleu clair.  

Modes d’analyse 

Trois modes d’analyse sont proposés sur le logiciel PyroMark Q24 MDx : AQ, 
CpG et SQA. Pour passer d’un mode à un autre, sélectionner « AQ », « CpG » 
ou « SQA » dans la barre d’outils. Le génotypage des SNP et des InDels est 
accessible dans le menu « Reports » du mode AQ. 
 

  
Remarque : Dans la mesure où le mode CpG ne prend pas en charge 
l’analyse automatique des SNP, les pourcentages de méthylation et les 
évaluations de la qualité sont déterminés uniquement pour les sites CpG. Au 
cours d’une analyse CpG, les SNP peuvent être analysés en mode AQ avec la 
séquence à analyser saisie dans la configuration de l’analyse CpG. Pour 
exclure les sites CpG des rapports de SNP, sélectionner l’onglet « Analysis 
Setup » (Configuration de l’analyse) et décocher l’option « Analyze » pour les 
positions concernées dans l’onglet « Variable Positions ». 

Affichage des résultats d’analyse 
En sélectionnant un puits analysé (bleu clair) dans l’onglet « Overview », le 
pyrogramme correspondant s’affiche et les informations relatives à ce puits (y 
compris les avertissements) apparaissent dans la zone « Well Information ». 
Lorsque plusieurs puits sont sélectionnés sur la vue d’ensemble d’une plaque, 
ce sont les informations sur le puits encadré en orange qui sont affichées.  
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Vue d’ensemble des résultats 

Les informations suivantes sur les puits peuvent être affichées dans la vue 
d’ensemble de la plaque dans l’onglet « Overview » : 
 

  Affiche le nom de l’analyse. 

 Affiche l’ID d’échantillon. 

 Affiche la note associée au puits. 

 Affiche la barre de qualité. La barre de qualité indique 
l’évaluation de la qualité de toutes les positions 
variables dans le puits ou de toutes les bases dans la 
séquence d’appel de bases. Voir la légende des 
couleurs page 49. 

 Affiche le pourcentage moyen de méthylation de tous 
les sites CpG du puits.  

 Affiche la barre de méthylation. La barre de 
méthylation indique le niveau de méthylation de 
chaque site CpG dans le puits. Voir la légende des 
couleurs page 50. 

Analyses AQ 

 
Analyses CpG 

 
Analyses SQA 

 
 Affiche l’évaluation de la qualité à la fin de la plage de 

contrôle qualité. Le nombre de bases inclues par 
défaut est de 20. 

 
Remarque : Les puits présentant un pic de substrat élevé sont marqués d’une 
icône d’information ( ) dans la vue d’ensemble de la plaque. Ceci est sans 
conséquence sur les évaluations de la qualité. 

Remarque : En cas de modification par l’utilisateur de paramètres d’analyse, 
d’évaluations de la qualité ou de résultats d’analyse (analyses SQA 
uniquement), le puits est marqué d’une icône d’avertissement ( ). 

Remarque : En cas de verrouillage d’une analyse, le puits est marqué de 
l’icône . 

Impression et exportation de la vue d’ensemble d’une plaque sous 
forme d’image 
Pour imprimer la vue d’ensemble de la plaque ou la copier dans le presse-
papier sous forme d’image, cliquer avec le bouton droit de la souris sur la vue 
d’ensemble et sélectionner « Print » ou « Copy as Image » dans le menu 
contextuel. Il est possible de coller l’image dans des applications qui prennent 
en charge le format EMF (Enhanced Metafile). 
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Avertissements d’analyse 

En sélectionnant un puits analysé (bleu clair), les avertissements (le cas échéant) 
s’affichent dans la zone « Well Information ». Les avertissements d’analyse 
affectent l’évaluation de la qualité de la manière suivante : 

 Analyses AQ et CpG : Ils affectent l’évaluation de la qualité de toutes les 
positions variables ou d’une seule position. Si plusieurs avertissements du 
même type sont déclenchés, seuls les plus importants sont affichés dans la 
zone « Well Information ». 

 Analyses SQA : Ils affectent l’évaluation de la qualité de la totalité de la 
séquence ou à partir d’une distribution spécifique et dans le sens direct. 
Tous les avertissements déclenchés dans la plage de contrôle qualité 
s’affichent dans la zone « Well Information ».  

Les critères de déclenchement et l’effet sur l’évaluation de la qualité de certains 
avertissements sont modifiables par l’utilisateur dans l’onglet « Analysis 
Parameters ». Voir Modification des paramètres d’analyse, page 51. 

Remarque : En cas d’erreur de distribution, il est recommandé de remplacer la 
cartouche de réactifs. 

Évaluations de la qualité 

Les évaluations de la qualité des résultats d’analyse sont représentées par les 
éléments suivants : 

 Barres de qualité ( ) de la vue d’ensemble de la plaque, voir page 48.  

 Couleur de fond des résultats d’analyse (fréquence des allèles ou 
pourcentage de méthylation sur le pyrogramme, par exemple , ou 
séquence d’appel de bases), voir page 48. 

 Plages de contrôle qualité ( ) de la vue d’ensemble de la plaque, voir 
page 48 (analyses SQA uniquement). 

 Les pics du pyrogramme compensé reprennent les couleurs des évaluations 
de la qualité (analyses SQA uniquement). 

Couleurs symbolisant la qualité 
 Bleu : Succès 

 Jaune : À vérifier 

 Rouge : Échec 

 Blanc : Non analysé. Soit l’analyse n’est pas prise en charge par le logiciel 
(par exemple, analyse des SNP en mode CpG), soit la position variable a 
été désélectionnée par l’utilisateur (analyses AQ et CpG uniquement) 
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Niveaux de méthylation 

En mode CpG, une barre de méthylation indiquant le niveau de méthylation de 
chaque site CpG dans le puits est affichée dans l’onglet « Overview », voir 
page 48. 

Couleurs symbolisant la méthylation 
 Vert clair : Valeur inférieure à la plage attendue 

 Vert : Valeur dans la plage attendue 

 Vert foncé : Valeur supérieure à la plage attendue 

Affichage et comparaison des pyrogrammes 

La sélection d’un puits analysé dans l’onglet « Overview » permet d’afficher le 
pyrogramme correspondant, ainsi que l’histogramme théorique (analyses AQ 
ou CpG) ou le pyrogramme compensé (analyses SQA). 
 

 
 

Lors de la sélection d’une base de la séquence d’appel de bases, le pic correspondant est mis 
en surbrillance dans les deux zones du pyrogramme et vice versa. 

Comparaison des pyrogrammes de plusieurs puits 
Pour comparer le pyrogramme d’un puits donné (affiché dans la partie 
supérieure) à celui d’un ou de plusieurs puits (affichés dans la partie 
inférieure) : 

1. Dans l’onglet « Overview », sélectionner le ou les puits (voir 
Sélection des puits, page 19) à afficher dans la partie inférieure.  

2. Cliquer avec le bouton droit de la souris sur une sélection puis 
choisir « Open in Lower Area » (Ouvrir dans la partie inférieure) 
dans le menu contextuel. 
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3. Sélectionner le puits à afficher dans la partie supérieure. 
 

 

 
 
Si les pyrogrammes de plusieurs puits sont affichés dans la partie inférieure, 
utiliser la barre de défilement pour passer d’un pyrogramme à un autre.  

Il est possible de zoomer simultanément sur un pyrogramme dont la séquence 
à analyser est identique (zoom lié) en cliquant sur , dans le coin supérieur 
droit de la partie supérieure.  

Pour fermer la liste des pyrogrammes de la partie inférieure, cliquer sur  dans 
le coin supérieur droit de la partie inférieure. 

Zoom du pyrogramme et affichage de la signification des icônes et des 
couleurs 
Pour plus d’informations sur les icônes et les couleurs employées dans le 
pyrogramme et sur la fonction de zoom, voir Pyrogramme, page 17. 

Modification des paramètres d’analyse 
Les paramètres d’analyse par défaut ont été définis pour fournir des résultats 
optimaux pour la plupart des analyses. En cas de modification de ces 
paramètres, veiller à valider les nouvelles valeurs (voir l’Annexe B du Manuel 
d’utilisation du PyroMark Q24 MDx). 

Remarque : Lors de l’utilisation des kits QIAGEN, utiliser les paramètres 
indiqués dans le manuel correspondant. 

Remarque : Il est impossible de modifier les paramètres d’analyse des 
analyses verrouillées ( ). 

1. Sélectionner le ou les puits (voir Sélection des puits, page 19) dont 
les paramètres d’analyse sont à modifier.  
Remarque : Les modifications s’appliquent uniquement aux puits ayant 
une analyse et un ordre de distribution en commun avec le puits affiché. 
Pour modifier les paramètres d’analyse de tous les puits ayant une analyse 
et un ordre de distribution en commun, il suffit de sélectionner un seul de 
ces puits. 

2. Modifier les paramètres d’analyse dans l’onglet « Analysis Setup » : 
Pour activer ou désactiver l’analyse des positions variables et/ou modifier 
les plages de méthylation attendues (analyses CpG uniquement), voir 
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Configuration des positions variables, page 26. Pour modifier d’autres 
paramètres dans le cas d’une analyse AQ ou CpG, voir page 28. 

Pour modifier les paramètres d’analyse dans le cas d’une analyse SQA, voir 
page 35.  

Remarque : Il est impossible de modifier le nom de l’analyse, l’ordre de 
distribution et la note. 

3. Une fois les modifications apportées, cliquer sur « Apply » 
(Appliquer).  
Remarque : Il est également possible d’activer ou de désactiver les pics de 
référence et/ou les témoins de traitement par le bisulfite (analyses CpG 
uniquement) dans le pyrogramme dans l’onglet « Overview ». Voir les 
instructions page 32. Pour appliquer les modifications apportées au 
pyrogramme, cliquer sur le bouton vert . Ce bouton est actif lorsqu’une 
modification a été apportée.  

4. Dans la boîte de dialogue « Apply Analysis Setup » (Appliquer la 
configuration d’analyse), appliquer les modifications à l’ensemble ou 
à une sélection de puits : 
Pour appliquer les modifications à tous les puits ayant une analyse et un 
ordre de distribution en commun avec le puits affiché (c’est-à-dire tous les 
puits en blanc dans la boîte de dialogue « Apply Analysis Setup »), cliquer 
sur « To All » (À tout). 

Pour appliquer les modifications à une sélection de puits (c’est-à-dire les 
puits en blanc sélectionnés dans la boîte de dialogue « Apply Analysis 
Setup »), cliquer sur « To Selected » (À la sélection).  

Pendant l’analyse, une boîte de dialogue contenant une barre de 
progression, un bouton d’arrêt et le nom du puits en cours d’analyse 
affiche la progression. Pour arrêter l’analyse, cliquer sur « Stop ». 

5. Pour enregistrer les modifications, cliquer sur .  
Remarque : En cas de modification par l’utilisateur de paramètres 
d’analyse, d’évaluations de la qualité ou de résultats d’analyse (analyses 
SQA uniquement), le puits est marqué d’une icône d’avertissement ( ) dans 
l’onglet « Overview ». 

Remarque : Toutes les modifications sont consignées dans un journal. Pour 
afficher le journal d’analyse d’un puits sélectionné, choisir « Analysis Log » 
dans le menu « Tools ». 

Utilisation d’une analyse modifiée pour d’autres runs 

Les modifications apportées dans l’onglet « Analysis Setup » ne sont pas 
enregistrées dans le fichier d’analyse d’origine. Pour utiliser une analyse 
modifiée pour d’autres runs : 
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1. Sélectionner un puits associé à l’analyse modifiée et cliquer sur 
« Save Assay » (Enregistrer l’analyse). La boîte de dialogue « Save 
Assay As » (Enregistrer l’analyse sous) s’ouvre. 

2. Enregistrer les modifications dans le fichier d’origine ou dans un 
nouveau fichier : 
Sélectionner la destination (dossier) dans la liste déroulante « Save in » 
(Enregistrer dans). 

Saisir le nom de fichier dans la zone de texte « File name » (Nom de fichier) 
puis cliquer sur « Save ». 

Modification des évaluations de la qualité 
Pour modifier l’évaluation de la qualité de la fréquence des allèles ou d’un 
pourcentage de méthylation, cliquer avec le bouton gauche de la souris sur le 
résultat d’analyse dans le pyrogramme puis sélectionner « Passed », « Check » 
ou « Failed » dans le menu contextuel. 

Pour modifier l’évaluation de la qualité d’une séquence d’appel de bases, 
placer le pointeur de la souris sur l’extrémité gauche ou droite de la zone 
« Passed », « Check » ou « Failed » de manière à ce que le pointeur passe d’une 
flèche blanche au symbole  puis déplacer la souris vers la gauche ou la droite 
tout en maintenant le bouton gauche enfoncé. 
 

 
 
En cas de modification d’une évaluation de la qualité par l’utilisateur, cette 
information est représentée par une icône d’avertissement ( ) dans la vue 
d’ensemble de la plaque dans l’onglet « Overview », par un avertissement dans 
la zone « Well Information » et, dans le cas d’une analyse AQ ou CpG, par un 
cadre autour du résultat d’analyse sur le pyrogramme (par exemple, ). 

Remarque : Toutes les modifications sont consignées dans un journal. Pour 
afficher le journal d’analyse d’un puits sélectionné, choisir « Analysis Log » dans 
le menu « Tools ». 

Remarque : Les évaluations de la qualité générées par le logiciel reposent sur 
des algorithmes d’analyse perfectionnés. Il n’est pas recommandé de modifier 
les évaluations de la qualité. 

Remarque : Il est impossible de modifier les évaluations de la qualité des 
analyses verrouillées ( ). 

Remarque : Les modifications apportées en mode AQ sont sans conséquence 
sur les évaluations de la qualité dans les rapports SNP. 
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Modification des séquences d’appel de bases 
Pour modifier une séquence d’appel de bases, cliquer dessus avec le bouton 
droit de la souris et sélectionner l’option souhaitée. 
 

 
 
Remarque : Toutes les modifications sont consignées dans un journal. Pour 
afficher le journal d’analyse d’un puits sélectionné, choisir « Analysis Log » dans 
le menu « Tools ». 

Remarque : En cas de modification de la séquence d’appel de bases, noter 
que les évaluations de la qualité reposent toujours sur la séquence d’origine (la 
séquence appelée par le logiciel). Pour modifier les évaluations de la qualité, 
voir page 53. 

Remarque : Il est impossible de modifier la séquence d’appel de bases des 
analyses verrouillées ( ). 
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Affichage, impression et enregistrement des 
rapports d’analyse 
Le logiciel PyroMark Q24 MDx propose les rapports d’analyse suivants pour les 
runs traités. 
 

Rapports pour les runs 
CpG 

 
Rapports pour les runs 
AQ 

 
Rapports pour les runs 
SQA 

 
 

 Rapport « Analysis Statistics » : Ce rapport fournit 
les statistiques d’analyse de tous les puits ou 
d’une sélection de puits. 

 Rapport « Analysis Results » : Ce rapport fournit 
des informations et les résultats d’analyse de tous 
les puits ou d’une sélection de puits. 

 Rapport « Pyrogram Report » : Il fournit des 
informations et le pyrogramme de tous les puits 
ou d’une sélection de puits. 

 Rapport « Full report » : Il comprend les 
paramètres et le journal du run, les informations 
sur les puits et les résultats d’analyse 
(pyrogramme compris) pour tous les puits ou une 
sélection de puits. 

 Rapport « SNP Overview Report » : Il comprend 
les génotypes et les évaluations de la qualité de 
tous les SNP et InDels. Les informations sont 
présentées sous forme de vues d’ensemble des 
plaques avec une plaque par numéro de position. 

Remarque : Un lecteur de document PDF doit être 
installé sur l’ordinateur pour pouvoir lire les rapports 
au format PDF. Il est possible de télécharger Adobe 
Reader à partir du site www.adobe.com. 
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Rapport « Analysis Statistics » (Statistiques d’analyse) 
 

 

 
 
Ce rapport fournit les informations suivantes sur les positions variables de tous 
les puits ou d’une sélection de puits (voir Sélection de puits, page 19) : 

 Fréquence moyenne des allèles (rapport QA) ou pourcentage moyen de 
méthylation (rapport CpG) 

 Valeurs maximale et minimale de la fréquence des allèles (analyses QA) ou 
du pourcentage de méthylation (rapport CpG) 

 Écart-type 

 Nombre de valeurs et puits utilisés pour chaque calcul 

 Le cas échéant, indication de la modification des paramètres d’analyse ou 
des évaluations de la qualité par l’utilisateur, les puits affectés étant 
énumérés en début de rapport. 

Le rapport peut être enregistré sous forme de fichier texte (*.tsv ou *.csv) ou de 
fichier HTML (.html). Il est possible d’importer le rapport dans Microsoft Excel 
ou une autre application capable de prendre en charge les fichiers texte (*.tsv 
ou *.csv) avec des données séparées par des points-virgules (;) ou des 
tabulations. Ceci est utile à la réalisation de calculs supplémentaires sur les 
données. 

Options du rapport 

La boîte de dialogue « Analysis Statistics Report » (Rapport des statistiques 
d’analyse) contient les options suivantes : 
 

« All wells/Selected 
wells » (Tous les 
puits/sélection de puits) 

Puits à inclure dans le rapport. 
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« Assay/Assay and 
sample ID » 
(Analyse/Analyse et ID 
d’échantillon) 

Les statistiques des résultats d’analyse peuvent être 
regroupées par : 

 Analyse 
Les puits associés à la même analyse sont 
regroupés. 

 Analyse et ID d’échantillon 
Les puits associés à la même analyse et au même 
ID d’échantillon sont regroupés. Cette option peut 
être utile lors d’expériences avec des réplicats. 

« Passed/Check » 
(Succès/À vérifier) 

Résultats d’analyse à inclure. Les calculs peuvent être 
effectués sur les résultats dont l’évaluation de la 
qualité est « Passed » et/ou « Check ». 

Remarque : Si tous les résultats dont l’évaluation de 
la qualité est « Passed » ou « Check » sont à inclure 
dans le rapport, il est possible d’exclure des résultats 
de ce groupe en désactivant l’option « Analyze » pour 
les positions concernées dans l’onglet « Analysis 
Setup ». Voir Configuration des positions variables, 
page 26. 

 
Pour afficher le rapport avant de l’enregistrer ou de l’imprimer, cliquer sur 
« Preview » (Aperçu). 

Rapport « Analysis Results » (Résultats d’analyse) 
 

 

    

 
 
Ce rapport fournit les informations suivantes pour tous les puits ou une 
sélection de puits (voir Sélection de puits, page 19) : 

 Informations sur le puits (nom du puits, nom de l’analyse et ID 
d’échantillon) 

 Fréquence des allèles (rapport QA), génotypes (rapport SNP), pourcentage 
de méthylation (rapport CpG) ou séquences d’appel de bases (rapport 
SQA) ainsi que les évaluations de la qualité 

 Pourcentage moyen de méthylation et écart-type de tous les sites CpG 
ayant atteint le critère de qualité « Passed » pour un puits (rapport CpG 
uniquement) 
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 Valeurs maximale et minimale du pourcentage de méthylation pour un 
puits (rapport CpG uniquement) 

 Indication de la modification des paramètres d’analyse, des évaluations de 
la qualité et des résultats d’analyse par l’utilisateur (rapport SQA 
uniquement) 

Facultatif : Version de l’analyse, notes sur les puits et avertissements d’analyse. 
Dans les rapports d’analyses AQ et CpG, il est également possible d’inclure les 
noms ainsi que les évaluations de la qualité d’origine et/ou actives des 
positions variables.  

Le rapport peut être enregistré sous forme de fichier texte (*.tsv ou *.csv) ou de 
fichier HTML (.html). Il est possible d’importer le rapport dans Microsoft Excel 
ou une autre application capable de prendre en charge les fichiers texte (*.tsv 
ou *.csv) avec des données séparées par des points-virgules (;) ou des 
tabulations. Ceci est utile à la réalisation de calculs supplémentaires sur les 
données. La première ligne du rapport comporte le nom du run. Les deux ou 
trois lignes suivantes comportent les en-têtes des colonnes. Chacune des lignes 
suivant l’en-tête de colonne contient des informations détaillées et les 
statistiques d’un puits spécifié. 

Options du rapport 

La boîte de dialogue « Analysis Results Report » (Rapport des résultats d’analyse) 
contient les options suivantes : 
 

« All wells/Selected 
wells » 

Puits à inclure dans le rapport. 

« Sort by row/column » Ordre de tri des puits. 

« All/Passed/Passed + 
Check/Only Quality 
Window » 
(Tout/Succès/Succès + 
À vérifier/Plage de 
contrôle qualité 
uniquement) 

Bases de la séquence d’appel à inclure dans le 
rapport. 

Cette option est disponible uniquement pour le 
rapport SQA. 

« Note column » 
(Colonne Note) 

Lorsque cette option est cochée, une colonne 
contenant les notes des puits est ajoutée au rapport. 

« Warnings column » 
(Colonne 
Avertissements) 

Lorsque cette option est cochée, une colonne 
contenant les avertissements d’analyse est ajoutée au 
rapport. 
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« Analysis version 
column » (Colonne 
Version d’analyse) 

Lorsque cette option est cochée, une colonne 
contenant la version de l’analyse est ajoutée au 
rapport. 

« Position name 
column » (Colonne 
Nom de la position) 

Lorsque cette option est cochée, une colonne 
contenant le nom des positions variables est ajoutée 
au rapport. 

Cette option n’est pas disponible pour le rapport 
SQA. 

« Quality column » 
(Colonne Qualité) 

Lorsque cette option est cochée, une colonne 
contenant les évaluations de la qualité actives est 
ajoutée au rapport. 

« Original quality 
column » (Colonne 
Qualité d’origine) 

Lorsque cette option est cochée, une colonne 
contenant les évaluations de la qualité d’origine est 
ajoutée au rapport. 

Cette option n’est pas disponible pour le rapport 
SQA. 

 
Pour afficher le rapport avant de l’enregistrer ou de l’imprimer, cliquer sur 
« Preview ».  

Rapport « Pyrogram report » (Rapport du pyrogramme) 
 

 

   

 
Ce rapport fournit des informations sur les puits (nom du puits, nom de 
l’analyse, ID d’échantillon et note du puits) et le pyrogramme de tous les puits 
ou d’une sélection de puits (voir Sélection de puits, page 19). Le cas échéant, il 
indique la modification des paramètres d’analyse, des évaluations de la qualité 
et des résultats d’analyse par l’utilisateur (rapport SQA uniquement). 

Les rapports AQ, SNP et CpG utilisent les informations, les icônes et les 
couleurs suivantes : 

 Nom du puits et séquence à analyser 

 Le résultat d’analyse (fréquence des allèles (rapport AQ), génotypes 
(rapport SNP) ou pourcentage de méthylation (rapport CpG)) est affiché 
au-dessus de chaque position variable, par exemple  (indel) et . La 
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couleur de fond reflète l’évaluation de la qualité du résultat d’analyse. Voir 
la légende des couleurs page 49  

Remarque :  (en blanc) = désélectionné par l’utilisateur.  (en blanc ) 
= analyse non prise en charge par le logiciel, cas par exemple d’une 
analyse SNP en mode CpG.  (en rouge) = analyse impossible en raison 
du manque de données. 

 Si cela est souhaité, les positions variables sont mises en évidence par une 
couleur de fond bleu-gris. 

 Les témoins du traitement par le bisulfite sont mis en évidence par une 
couleur de fond jaune pâle (rapport CpG uniquement). 

Le rapport SQA utilise les informations et les couleurs suivantes : 

 Nom du puits 

 Séquence d’appel de bases. La couleur de fond d’une base de la séquence 
reflète l’évaluation de sa qualité. Voir la légende des couleurs page 49 

 Si un pyrogramme compensé est inclus, ses pics reprennent les couleurs 
des évaluations de la qualité. 

Options du rapport 

La boîte de dialogue « Pyrogram Report » contient les options suivantes : 
 

« All wells/Selected 
wells » 

Puits à inclure dans le rapport. 

« Number of 
rows/columns » 
(Nombre de 
lignes/colonnes) 

Nombre de colonnes et de lignes d’un pyrogramme 
sur chaque page. 

« Sort by row/column » Ordre de tri des puits. 

« Portrait/Landscape » 
(Portrait/Paysage) 

Orientation du papier. 

« Highlight variable 
regions » (Mettre en 
surbrillance les régions 
variables) 

Lorsque cette option est cochée, les régions variables 
sont mises en évidence par une couleur de fond 
bleu-gris. 

Cette option n’est pas disponible pour le rapport 
SQA. 
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« Show peak levels » 
(Afficher les niveaux de 
pic) 

Lorsque cette option est cochée, les niveaux de pic 
calculés sont affichés sur le pyrogramme. 

Cette option est disponible uniquement pour le 
rapport SQA. 

« Raw Pyrogram/ 
Compensated 
Pyrogram » 
(Pyrogramme 
brut/Pyrogramme 
compensé) 

Type de pyrogramme à inclure dans le rapport. 

Cette option est disponible uniquement pour le 
rapport SQA. 

« Paper size » (Format 
du papier) 

Format du papier (A4, A3, lettre ou tabloïde) 

 
Pour afficher le rapport avant de l’enregistrer ou de l’imprimer, cliquer sur 
« Preview ». 

Remarque : Un lecteur de document PDF doit être installé sur l’ordinateur pour 
pouvoir afficher le rapport. Il est possible de télécharger Adobe Reader à partir 
du site www.adobe.com. 

Rapport « Full report » (Rapport complet) 
 

 

    

 
Ce rapport fournit les informations suivantes pour tous les puits ou une 
sélection de puits (voir Sélection de puits, page 19) : 

 Paramètres du run (nom, date et heure du run, méthode de l’appareil, 
nom de l’appareil, numéro de série, opérateur, ID de plaque, code-barres, 
ID de réactif et note de run) et journal 

 Informations sur le puits (nom du puits, nom de l’analyse, ID d’échantillon 
et note du puits), version de l’analyse, analyse AQ ou CpG, séquence à 
analyser 

 Pyrogramme. Pour plus d’informations sur les icônes et les couleurs 
employées dans le pyrogramme, voir Rapport Pyrogram report, page 59 

 Fréquence des allèles (rapport QA), génotypes (rapport SNP), pourcentage 
de méthylation (rapport CpG) ou séquences d’appel de bases (rapport 
SQA) ainsi que les évaluations de la qualité  
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 Avertissements d’analyse 

 Le cas échéant, indication de la modification des paramètres d’analyse ou 
des évaluations de la qualité par l’utilisateur, les puits affectés étant 
énumérés. 

Options du rapport 
La boîte de dialogue « Full Report » contient les options suivantes : 

« All wells/Selected 
wells » 

Puits à inclure dans le rapport. 

« Raw Pyrogram/ 
Compensated 
Pyrogram » 

Type de pyrogramme à inclure dans le rapport. 

Cette option est disponible uniquement pour le 
rapport SQA. 

 
Pour afficher le rapport avant de l’enregistrer ou de l’imprimer, cliquer sur 
« Preview ». 

Remarque : Un lecteur de document PDF doit être installé sur l’ordinateur pour 
pouvoir afficher le rapport. Il est possible de télécharger Adobe Reader à partir 
du site www.adobe.com. 

Rapport « SNP Overview Report » (Rapport d’ensemble des 
SNP) 
 

 

 
 
Ce rapport comprend les génotypes et les évaluations de la qualité de tous les 
SNP et InDels. Les informations sont présentées sous forme de vues d’ensemble 
des plaques avec une plaque par numéro de position. La couleur de fond des 
puits reflète l’évaluation de la qualité du SNP. Voir la légende des couleurs 
page 49.  

En cas de modification des paramètres d’analyse par l’utilisateur, les puits 
affectés sont énumérés en début de rapport. 

Pour afficher le rapport avant de l’enregistrer ou de l’imprimer, cliquer sur 
« Preview » dans la boîte de dialogue « SNP Overview Report ». 
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Extrait d’un rapport. L’option « Analyze » a été désactivée pour les positions 1 et 2 du puits A5. 
Les puits A3, A4, B3, B4, C3 et C4 ne présentent aucun SNP ni InDel en position 2.  

Remarque : Il est possible d’exclure des positions variables du rapport en 
désactivant l’option « Analyze » correspondante dans l’onglet « Analysis Setup ». 
Voir Configuration des positions variables, page 26. 

Remarque : Le rapport « SNP Overview Report » est disponible uniquement en 
mode AQ. Un lecteur de document PDF doit être installé sur l’ordinateur pour 
pouvoir afficher le rapport. Il est possible de télécharger Adobe Reader à partir 
du site www.adobe.com. 

Gestion des méthodes de l’appareil 
 

 
 
Il convient de choisir la méthode de l’appareil en fonction des réactifs et de la 
cartouche de réactifs utilisés pour le run. Le numéro de la méthode imprimé sur 
la cartouche PyroMark Q24 correspond aux paramètres de la méthode 
spécifique donnés sur le site 
www.qiagen.com/Products/PyroMarkQ24MDx.aspx.  

Remarque : Il est recommandé d’utiliser uniquement les méthodes fournies par 
QIAGEN.  

Pour importer une nouvelle méthode : 

1. À partir du site Web ci-dessus, télécharger le fichier de la méthode 
correspondant au numéro de méthode imprimé sur l’étiquette de la 
cartouche. L’enregistrer sur l’ordinateur exécutant le logiciel 
PyroMark Q24 MDx.  

2. Dans la boîte de dialogue « Instrument Methods », cliquer sur 
« Import ». La boîte de dialogue « Find Instrument Method » 
(Recherche d’une méthode de l’appareil) s’ouvre. 

3. Localiser et sélectionner la méthode à importer puis cliquer sur 
« Open ». 
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Pour créer une nouvelle méthode : 

1. Dans la boîte de dialogue « Instrument Method », sélectionner une 
méthode existante puis cliquer sur « Save As ». 

2. Nommer la nouvelle méthode puis appuyer sur « Enter ». 
3. Modifier les paramètres de la méthode dans la boîte de dialogue 

pour qu’ils correspondent à ceux donnés sur la page 
www.qiagen.com/Products/PyroMarkQ24MDx.aspx.  

4. Cliquer sur « Save ». 

Paramètres de la méthode 
La boîte de dialogue « Instrument Methods » comporte les paramètres suivants : 
 

« Reagent pressure » 
(Pression des réactifs) 

Pression (en millibar) de distribution des mélanges 
d’enzymes et de substrats 

« Enzyme pulse time » 
(Durée d’impulsion 
pour les enzymes) 

Durée (en millisecondes) de distribution du mélange 
d’enzymes 

« Substrate pulse time » 
(Durée d’impulsion 
pour les substrats) 

Durée (en millisecondes) de distribution du mélange 
de substrats 

« Nucleotide pressure » 
(Pression des 
nucléotides) 

Pression (en millibar) de distribution des nucléotides  

« Nucleotide pulse 
time » (Durée 
d’impulsion pour les 
nucléotides) 

Durée (en millisecondes) de distribution des 
nucléotides  

« Note » Remarque concernant la méthode de l’appareil 
(facultative). 
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Trucs et astuces 

Validation des analyses 
Valider les analyses à l’aide d’échantillons d’ADN de référence, voir l’Annexe B 
du Manuel d’utilisation du PyroMark Q24 MDx. 

Journal d’analyse 
Toutes les analyses réalisées sont consignées avec leurs paramètres, leur mode 
(AQ, CpG ou SQA), leur version, les résultats (avertissements d’analyse 
compris), la date et l’heure de l’analyse et l’opérateur. Pour que les données 
sur l’opérateur de l’analyse et sur l’auteur d’un fichier d’analyse ou de run 
soient correctes, tous les utilisateurs doivent se connecter à Windows avec leur 
propre compte d’utilisateur. Pour plus d’informations sur les comptes 
d’utilisateur, la connexion et la déconnexion, voir l’aide en ligne de Windows 
ou contacter l’administrateur système. 

Pour afficher le journal d’analyse d’un puits sélectionné, choisir « Analysis Log » 
dans le menu « Tools ». 

Protection des fichiers 
Pour protéger un fichier contre la modification par un autre utilisateur, 
l’enregistrer dans un dossier inaccessible par autrui. Pour plus d’informations, 
contacter l’administrateur système.  

Pour protéger un fichier contre le remplacement accidentel, attribuer au fichier 
la propriété « Read-only » (Lecture seule) dans Windows Explorer : 

1. Fermer le fichier dans le logiciel PyroMark Q24 MDx. 
2. Ouvrir Windows Explorer et localiser le fichier.  

Pour cela, cliquer avec le bouton droit de la souris sur le dossier contenant 
le fichier dans le navigateur des raccourcis puis sélectionner « Explore » 
dans le menu contextuel. 

3. Dans Windows Explorer, cliquer avec le bouton droit de la souris sur 
le fichier puis sélectionner « Properties » (Propriétés) dans le menu 
contextuel. 

4. Dans la boîte de dialogue « Properties » (Propriétés) qui s’ouvre, 
cocher ( ) l’attribut « Read-only » (Lecture Seule) puis cliquer sur 
« OK ».  

Il convient de sauvegarder les données fréquemment.  
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Protection des résultats d’analyse 
Il est impossible de modifier les paramètres d’analyse et les résultats des 
analyses verrouillées ( ). Pour verrouiller une analyse, ouvrir le fichier d’analyse 
et cliquer sur le bouton « Lock Assay » en bas de la fenêtre de configuration de 
l’analyse. Verrouiller l’analyse avant de l’ajouter à une plaque.  
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Résolution des principaux problèmes rencontrés 
 

Erreur Commentaires et suggestions 

a) En cours d’analyse, 
présence d’une croix 
rouge sur les puits dans 
l’onglet « Overview » 

Contacter les Services techniques de QIAGEN. 

b) Affichage de la boîte 
de dialogue 
« Exception » 

Enregistrer le rapport d’erreur et l’envoyer aux 
Services techniques de QIAGEN pour 
information. Cliquer sur « Continue » pour 
poursuivre l’analyse. Si la boîte de dialogue reste 
affichée, cliquer sur « Quit » (Quitter) et 
redémarrer le logiciel. 

c) Impossible de créer 
une analyse à partir 
d’un fichier spécifié du 
logiciel PyroMark Assay 
Design 

Vérifier que le type de fichier d’analyse à 
importer est valide (AQ, CpG ou SNP). 

 
En cas de problème lié à l’analyse, voir la Section Résolution des problèmes du 
Manuel d’utilisation du PyroMark Q24 MDx. 

Pour plus d’informations, voir la page Foire aux Questions du Centre de 
support technique : www.qiagen.com/FAQ/FAQList.aspx. Les scientifiques des 
Services techniques de QIAGEN seront ravis de répondre à toutes les questions 
sur les informations figurant dans ce guide d’utilisation ou sur les technologies 
d’échantillons et d’analyses (pour les coordonnées, voir quatrième de 
couverture ou le site www.qiagen.com). 
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Annexe A : Messages du logiciel PyroMark Q24 MDx 
Voici une liste de messages d’utilisation, d’avertissement et d’erreur susceptibles 
de s’afficher dans le logiciel PyroMark Q24 MDx lors de la configuration d’une 
analyse, d’un run et de l’analyse des données. 

Énoncé du message Explication 

Messages généraux liés à la configuration 

« The dispensation order is 
very long » (Ordre de 
distribution très long) 

L’ordre de distribution contient plus de 
200 bases. 

Messages généraux liés à l’analyse 

« Not analyzable due to 
lack of data (overall) » 
(Analyse impossible en 
raison du manque de 
données (général)) 

Nombre de pics du pyrogramme insuffisant pour 
analyser les données. Cet avertissement annule 
tous les autres. 

« High pre-sequencing 
signal » (Signal de 
préséquençage élevé) 

Le pic du substrat est haut comparativement au 
bruit et au niveau de pic mononucléotidique. 

« Uncertain due to 
baseline drift. » 
(Incertitude due à une 
dérive de la ligne de base) 

Une dérive anormale de la ligne de base peut 
avoir un effet négatif sur le résultat. 

« Failed due to possible 
dispensation error at 
dispensation » (Échec dû à 
une possible erreur de 
distribution) 

Une erreur a pu se produire lors de la 
distribution indiquée. Ceci affecte la qualité de 
tous les sites de la séquence situés après l’erreur. 

« No peaks detected 
between dispensations » 
(Aucune détection de pic 
entre les distributions) 

Aucun pic n’est détecté bien que tous les 
nucléotides aient été distribués, ce qui peut 
indiquer un problème relatif à l’unité de 
distribution. Ceci affecte la couleur signalant la 
qualité de tous les sites de la séquence situés 
après l’erreur. 

« Uncertain due to wide 
peaks » (Incertitude due à 
des pics larges) 

La largeur moyenne de pic dépasse la limite de 
vérification. Ceci affecte la qualité de tous les 
sites de la séquence. 
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Énoncé du message Explication 

Messages de configuration d’analyse en mode AQ 

« Invalid sequence » 
(Séquence non valide) 

Erreur de saisie de la séquence à analyser. 

« Variable positions with 
common dispensations 
cannot be analyzed » 
(Impossible d’analyser des 
positions variables avec 
des distributions 
communes) 

Déphasage des distributions de nucléotide pour 
plusieurs polymorphismes. 

« The generated 
dispensation order 
contains less reference 
peaks than required » 

L’analyse comprend moins de 5 pics constants 
dont la valeur attendue est supérieure à 1. 

« Sequence uncertain due 
to lack of terminal 
sequence information » 

Le dernier nucléotide de la séquence à analyser 
a été distribué, ce qui signifie que la hauteur de 
pic attendue pour la dernière distribution est 
inconnue.  

Remarque : La séquence à analyser doit 
comporter un nucléotide de plus que l’ordre de 
distribution. 

« Last variable position not 
analyzable due to lack of 
terminal sequence 
information » (Analyse de 
la dernière position 
variable impossible en 
raison du manque 
d’informations sur la 
séquence terminale) 

Aucune informations sur la séquence au-delà de 
la dernière région variable n’a été saisie, ce qui 
signifie que la hauteur de pic attendue pour la 
position variable est inconnue. 

Remarque : La séquence à analyser doit 
comporter un nucléotide de plus que l’ordre de 
distribution. 

« Sequence not in phase at 
the end of dispensations » 
(Déphasage de la 
séquence à la fin des 
distributions) 

La séquence est déphasée après la distribution 
de tous les nucléotides, ce qui signifie que la 
hauteur de pic attendue pour la position variable 
est inconnue. 
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Énoncé du message Explication 

« Quantification may be 
uncertain: the variable 
position consists of more 
than 5 dispensations » 
(Incertitude de 
quantification : plus de 
5 distributions pour la 
position variable) 

La distribution des nucléotides est déphasée au 
niveau d’un polymorphisme pour plus de 
5 distributions, ce qui peut avoir un effet négatif 
sur le résultat. 

« Quantification may be 
uncertain: the variable 
position requires more 
than 5 variable 
dispensations » (Incertitude 
de quantification : position 
variable exigeant plus de 
5 distributions variables) 

Une position d’InDel exige l’analyse de plus de 
5 distributions, ce qui peut avoir un effet négatif 
sur le résultat. 

« Quantification may be 
uncertain: the variable 
position contains a 
homopolymer. » 
(Incertitude de 
quantification : présence 
d’un homopolymère sur la 
position variable) 

Un homopolymère d’une hauteur ≥ 3 précède 
ou suit une InDel d’une seule base. 
L’avertissement indique que le site est très 
difficile à analyser. 

Messages d’analyse en mode AQ 

« Analysis not supported » 
(Analyse non prise en 
charge) 

Le site variable n’est pas pris en charge en mode 
AQ. 

« Deselected by user » 
(Désélection par 
l’utilisateur) 

Le site variable a été exclu de l’analyse par 
l’utilisateur. 

« The sequence contains 
less reference peaks than 
required » (Nombre de 
pics de référence dans la 
séquence inférieur au 
nombre exigé) 

Le pyrogramme comprend moins de 5 pics 
constants dont la valeur attendue est supérieure 
à 1. 
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Énoncé du message Explication 

« Not analyzable due to 
lack of data » (Analyse 
impossible en raison du 
manque de données) 

Nombre de pics d’un site insuffisant pour 
analyser les données. 

« The variable position 
contains a 
homopolymer. » (Présence 
d’un homopolymère sur la 
position variable) 

Un homopolymère d’une hauteur ≥ 3 précède 
ou suit une InDel d’une seule base. 
L’avertissement indique que le site est très 
difficile à analyser. 

« Uncertain due to low 
signal-to-noise ratio » 
(Incertitude due à un 
faible rapport signal/bruit) 

La différence entre la somme des pics de la 
région variable et le bruit n’est pas significative, 
ce qui peut avoir un effet négatif sur le résultat. 

« Failed due to low signal-
to-noise ratio » (Échec dû 
à un faible rapport 
signal/bruit) 

La différence entre la somme des pics de la 
région variable et le bruit n’est pas significative, 
ce qui peut avoir un effet négatif sur le résultat. 

« Uncertain due to low 
peak height » 

Le niveau de pic mononucléotidique au début du 
pyrogramme est inférieur à celui exigé par le 
critère de qualité « Passed » défini dans la 
configuration de l’analyse. 

« Failed due to low peak 
height » 

La hauteur du pic en RLU à la position indiquée 
est inférieure à la valeur prédéfinie pour le 
critère de qualité « Failed ». 

« Uncertain due to high 
sum deviation in variable 
position » (Incertitude due 
à un écart important de la 
somme pour les positions 
variables) 

La somme des pics d’une région variable n’est 
pas égale au niveau de pic mononucléotidique 
attendu à la position du polymorphisme, 
dépassant la limite de vérification. 

« Failed due to high sum 
deviation in variable 
position » (Échec dû à un 
écart important de la 
somme pour les positions 
variables) 

La somme des pics d’une région variable n’est 
pas égale au niveau de pic mononucléotidique 
attendu à la position du polymorphisme, 
dépassant la limite d’échec. 
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Énoncé du message Explication 

« Uncertain due to high 
pattern deviation in 
variable position » 
(Incertitude due à un écart 
important du tracé pour la 
position variable) 

La meilleure correspondance des tracés de 
fréquence possibles s’écarte du tracé réel, 
dépassant la limite de vérification. 

« Failed due to high 
pattern deviation in 
variable position » (Échec 
dû à un écart important 
du tracé pour la position 
variable) 

La meilleure correspondance des tracés de 
fréquence possibles s’écarte du tracé réel, 
dépassant la limite d’échec. 

« Uncertain surrounding 
reference sequence 
pattern » (Incertitude sur le 
tracé de la séquence de 
référence environnante) 

La hauteur mesurée des pics dans la plage de 
contrôle qualité s’écarte des valeurs attendues, 
dépassant la limite de vérification. 

« Failed surrounding 
reference sequence 
pattern » (Échec du tracé 
de la séquence de 
référence environnante) 

La hauteur mesurée des pics dans la plage de 
contrôle qualité s’écarte des valeurs attendues, 
dépassant la limite d’échec. 

« Uncertain due to high 
peak height deviation at 
dispensation » (Incertitude 
due à un écart important 
de la hauteur de pic à la 
distribution) 

La hauteur mesurée du pic à la distribution 
spécifiée s’écarte de la valeur attendue, 
dépassant la limite de vérification. 

« Failed due to high peak 
height deviation at 
dispensation » (Échec dû à 
un écart important de la 
hauteur de pic à la 
distribution) 

La hauteur mesurée du pic à la distribution 
spécifiée s’écarte de la valeur attendue, 
dépassant la limite d’échec. 
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Énoncé du message Explication 

« Uncertain reference 
sequence pattern at more 
than 5 dispensations » 
(Incertitude du tracé de la 
séquence environnante 
pour plus de 
5 distributions) 

La hauteur mesurée des pics s’écarte des valeurs 
attendues pour plus de 5 distributions, dépassant 
la limite de vérification. 

« Failed reference 
sequence pattern at more 
than 5 dispensations » 
(Échec du tracé de la 
séquence environnante 
pour plus de 
5 distributions) 

La hauteur mesurée des pics s’écarte des valeurs 
attendues pour plus de 5 distributions, dépassant 
la limite d’échec. 

Messages d’analyse en mode SNP 

« Failed genotype 
determination » (Échec de 
la détermination du 
génotype) 

La différence entre la meilleure correspondance 
du génotype et la seconde est inférieure à la 
limite d’échec. 

« Uncertain genotype 
determination » 
(Incertitude de 
détermination du 
génotype) 

La différence entre la meilleure correspondance 
du génotype et la seconde est inférieure à la 
limite de vérification. 

Messages de configuration d’analyse en mode CpG 

« Invalid sequence » Erreur de saisie de la séquence à analyser. 

« Cannot resolve sequence 
direction » (Sens de la 
séquence indétectable) 

La séquence à analyser saisie comprend des 
nucléotides spécifiques de séquences directe ou 
inverse traitées par le bisulfite. 

« A CpG site has to be 
biallelic » (Un site CpG 
doit être biallélique.) 

Ce message s’affiche lorsque le site CpG 
indiqué comprend un polymorphisme 
supplémentaire, par exemple C/T/AG. 
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Énoncé du message Explication 

« Variable positions with 
common dispensations 
cannot be analyzed » 

Déphasage des distributions de nucléotide pour 
plusieurs polymorphismes.  

Il est impossible d’analyser une région variable 
évaluée avec des distributions de nucléotide qui 
s’appliquent à plus d’un polymorphisme 
(distribution commune). Par exemple, la 
séquence à analyser A/GC/TCAC avec l’ordre 
de distribution CATCGTCA n’est pas analysée 
car les distributions seraient déphasées. 

« The generated 
dispensation order 
contains less reference 
peaks than required » 

L’analyse comprend moins de 5 pics constants 
dont la valeur attendue est supérieure à 1. 

« Sequence uncertain due 
to lack of terminal 
sequence information » 

Le dernier nucléotide de la séquence à analyser 
a été distribué, ce qui signifie que la hauteur de 
pic attendue pour la dernière distribution est 
inconnue. 

« Last variable position not 
analyzable due to lack of 
terminal sequence 
information » 

Aucune informations sur la séquence au-delà de 
la dernière région variable n’a été saisie, ce qui 
signifie que la hauteur de pic attendue pour la 
position variable est inconnue. 

« Sequence not in phase at 
the end of dispensations » 

La séquence est déphasée après la distribution 
de tous les nucléotides, ce qui signifie que la 
hauteur de pic attendue pour la position variable 
est inconnue. 

« Quantification may be 
uncertain: the variable 
position consists of more 
than 5 dispensations » 

La distribution des nucléotides est déphasée au 
niveau d’un polymorphisme pour plus de 
5 distributions, ce qui peut avoir un effet négatif 
sur le résultat. 

Messages d’analyse en mode CpG 

« Analysis not supported » Le site variable n’est pas pris en charge en mode 
CpG. 

« Deselected by user » Le site variable a été exclu de l’analyse par 
l’utilisateur. 
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Énoncé du message Explication 

« Uncertain bisulfite 
conversion at 
dispensation » 

Le pic du témoin de traitement par le bisulfite 
aux distributions indiquées est supérieur à la 
limite de vérification. Ceci affecte la qualité de 
tous les sites de la séquence. 

« Failed bisulfite 
conversion at 
dispensation » 

Le pic du témoin de traitement par le bisulfite 
aux distributions indiquées est supérieur à la 
limite d’échec. Ceci affecte la qualité de tous les 
sites de la séquence. 

« The sequence contains 
less reference peaks than 
required » 

Le pyrogramme comprend moins de 5 pics 
constants dont la valeur attendue est supérieure 
à 1. 

« Not analyzable due to 
lack of data » 

Nombre de pics d’un site insuffisant pour 
analyser les données. 

« Uncertain due to low 
signal-to-noise ratio » 

La différence entre la somme des pics de la 
région variable et le bruit (inférieur à la limite de 
vérification) n’est pas significative, ce qui peut 
avoir un effet négatif sur le résultat. 

« Failed due to low 
signal-to-noise ratio » 

La différence entre la somme des pics de la 
région variable et le bruit (inférieur à la limite 
d’échec) n’est pas significative, ce qui peut avoir 
un effet négatif sur le résultat. 

« Uncertain due to low 
peak height » 

Le niveau de pic mononucléotidique au début du 
pyrogramme est inférieur à celui exigé par le 
critère de qualité « Passed » défini dans la 
configuration de l’analyse. 

« Failed due to low peak 
height » 

La hauteur du pic en RLU à la position indiquée 
est inférieure à la valeur prédéfinie pour le 
critère de qualité « Failed ». 

« Uncertain due to high 
sum deviation in variable 
position 

La somme des pics d’une région variable n’est 
pas égale au niveau de pic mononucléotidique 
attendu à la position du polymorphisme et la 
différence dépasse la limite de vérification. 

« Failed due to high sum 
deviation in variable 
position » 

La somme des pics d’une région variable n’est 
pas égale au niveau de pic mononucléotidique 
attendu à la position du polymorphisme et la 
différence dépasse la limite d’échec. 
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Énoncé du message Explication 

« Uncertain due to high 
pattern deviation in 
variable position » 

La meilleure correspondance des tracés de 
fréquence possibles s’écarte du tracé réel, 
dépassant la limite de vérification. 

« Failed due to high 
pattern deviation in 
variable position » 

La meilleure correspondance des tracés de 
fréquence possibles s’écarte du tracé réel, 
dépassant la limite d’échec. 

« Uncertain surrounding 
reference sequence 
pattern » 

La hauteur mesurée des pics dans la plage de 
contrôle qualité s’écarte des valeurs attendues, 
dépassant la limite de vérification. 

« Failed surrounding 
reference sequence 
pattern » 

La hauteur mesurée des pics dans la plage de 
contrôle qualité s’écarte des valeurs attendues, 
dépassant la limite d’échec. 

« Uncertain due to high 
peak height deviation at 
dispensation » 

La hauteur mesurée du pic à la distribution 
spécifiée s’écarte de la valeur attendue, 
dépassant la limite de vérification. 

« Failed due to high peak 
height deviation at 
dispensation » 

La hauteur mesurée du pic à la distribution 
spécifiée s’écarte de la valeur attendue, 
dépassant la limite d’échec. 

« Uncertain reference 
sequence pattern at more 
than 5 dispensations » 

La hauteur mesurée des pics s’écarte des valeurs 
attendues pour plus de 5 distributions, dépassant 
la limite de vérification. 

« Failed reference 
sequence pattern at more 
than 5 dispensations » 

La hauteur mesurée des pics s’écarte des valeurs 
attendues pour plus de 5 distributions, dépassant 
la limite d’échec. 

Messages en mode SQA 

« Base-calling not 
consistent with entered 
known bases » (Appel de 
bases incohérent avec les 
bases connues saisies) 

Des pics de normalisation définis par l’utilisateur 
ont été saisis et l’appel de bases résultant est 
incohérent avec les informations saisies.  

« Low peak height » 
(Faible hauteur de pic) 

Le niveau de pic mononucléotidique au début du 
pyrogramme est inférieur à celui exigé par le 
critère de qualité « Passed » défini dans la 
configuration de l’analyse. 
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Énoncé du message Explication 

« High homopolymer at 
dispensation » (Grand 
homopolymère à la 
distribution) 

Un homopolymère comportant plus de 
5 nucléotides est présent aux distributions 
spécifiées. 

« Large peak height 
variation » (Grande 
variation de la hauteur de 
pic) 

Dans l’ensemble, il y a une grande variation de 
la hauteur de pic. L’évaluation de la qualité 
obtenue au départ est de type incertitude ou 
échec si le phénomène se produit au cours des 
5 premières distributions. 

« Large peak height 
variation around 
dispensation » (Grande 
variation de la hauteur de 
pic autour de la 
distribution) 

Il existe une grande variation de la hauteur de 
pic pour les niveaux mononucléotidiques et 
binucléotidiques. Les distributions auxquelles cet 
avertissement s’applique sont spécifiées. 
L’évaluation de la qualité obtenue est de type 
incertitude ou échec pour la séquence à partir de 
la distribution en question. 

« Low signal-to-noise ratio 
(overall) » (Faible rapport 
signal/bruit (général)) 

Faible rapport signal/bruit. L’évaluation de la 
qualité obtenue au départ est de type incertitude 
ou échec si le phénomène se produit au cours 
des 5 premières distributions. 

« Low signal-to-noise ratio 
from dispensation » 
(Faible rapport 
signal/bruit à partir de la 
distribution) 

Faible rapport signal/bruit. L’évaluation de la 
qualité obtenue est de type incertitude ou échec 
pour la séquence à partir de la distribution en 
question. 

« Missing peaks in run 
starting at dispensation » 
(Pics de run manquant à 
partir de la distribution) 

Certains pics sont manquants pour le run. Les 
4 nucléotides ont été distribués mais aucun pic 
n’est détecté pour la séquence. L’évaluation de 
la qualité obtenue est de type incertitude pour le 
dernier pic détecté. 

« Peak height deviates 
from the expected peak 
level at dispensation » 

La hauteur mesurée du pic à la distribution 
spécifiée s’écarte fortement de la valeur 
attendue. Ceci affecte la couleur signalant la 
qualité de la distribution indiquée. 
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Énoncé du message Explication 

« Risk for overlaid 
sequence from 
dispensation » (Risque de 
superposition de séquence 
à partir de la distribution) 

Une possible séquence de fond est détectée dans 
une certaine région. Ceci affecte la couleur 
signalant la qualité à partir du début de cette 
région. 

« Spurious peak(s) at 
dispensation » (Présence 
de faux pics à la 
distribution) 

Des pics indéterminés sont détectés au-delà 
d’une certaine valeur. Ceci affecte la couleur 
signalant la qualité à partir de la distribution 
spécifiée. 

« Wide peaks from 
dispensation » (Pics larges 
à partir de la distribution) 

Détection de pics larges. L’évaluation de la 
qualité obtenue est de type incertitude à partir de 
la distribution pour laquelle le phénomène a été 
observé. L’évaluation de la qualité obtenue au 
départ est de type incertitude si le phénomène se 
produit au cours des 5 premières distributions.  
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Références 
QIAGEN tient à jour une grande banque de données en ligne de publications 
scientifiques utilisant les produits QIAGEN. Des critères de sélection de 
recherche aident à trouver les articles à l’aide un mot-clé ou en spécifiant 
l’application, le domaine de recherche, le titre, etc. 

Pour une liste complète des références, visiter notre banque de données en 
ligne « QIAGEN Reference Database » à l’adresse 
www.qiagen.com/RefDB/search.asp ou bien contacter les Services techniques 
de QIAGEN ou le distributeur local.
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Marques commerciales : QIAGEN®, Pyrogram®, PyroMark®, Pyrosequencing® (Groupe QIAGEN), Adobe®, Reader® (Adobe Systems Incorporated), 
Excel®, Microsoft®, Windows® (Microsoft Corporation). 

Accord de licence limitée 

En utilisant ce produit, l’acheteur ou l’utilisateur du système PyroMark Q24 MDx  accepte les conditions suivantes : 

1. Le logiciel PyroMark Q24 MDx ne doit être utilisé que conformément au Guide d’utilisation du logiciel PyroMark Q24 MDx et avec les 
composants fournis avec ce logiciel. QIAGEN n’accorde aucune licence sous sa propriété intellectuelle pour utiliser ou intégrer les composants 
fournis dans ce logiciel avec tout autre composant non fourni dans ce logiciel, à l’exception de ce qui est stipulé dans le Manuel d’utilisation du 
PyroMark Q24 MDx et autres protocoles disponibles sur le site www.qiagen.com. 

2. Hormis les licences énoncées expressément, QIAGEN n’offre aucune garantie indiquant que ce logiciel et/ou son(ses) utilisation(s) ne violent 
pas les droits de tiers. 

3. Ce logiciel et ses composants sont sous licence pour une utilisation unique et ne peuvent pas être réutilisés, remis à neuf ou revendus. 

4. QIAGEN rejette notamment toutes les autres licences, expresses ou tacites, autres que celles énoncées expressément. 

5. L’acheteur et l’utilisateur du logiciel consentent à ne pas prendre, ni autoriser quiconque à prendre, de quelconques mesures pouvant entraîner 
ou faciliter la réalisation d’actes interdits par les termes précédents. QIAGEN peut faire appliquer des interdictions de cet Accord de licence 
limitée par tout tribunal et pourra recouvrir tous ses frais de recherche et de justice, y compris les frais d’avocats, en cas d’action en application 
de cet Accord de licence limitée ou de tous ses droits de propriété intellectuelle liés au logiciel et/ou à ses composants. 

Pour les termes de licence mis à jour, voir www.qiagen.com. 

© 2010 QIAGEN, tous droits réservés. 
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